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Short description 

This manual is intended for users and machine operators. It explains the installation of the hardware 

and software, the initial commissioning and the basic steps in the daily handling of the machine. It 

is assumed that you already own a working milling machine or engraving machine that you have 

purchased together with the CNC control. In this case, the setting of the machine parameters is very 

easy and is limited to the selection of a pre-set parameters. The control can also be individually 

adapted to a large number of different machines. However, this requires the exact knowledge of the 

drive mechanism and the electrical wiring. For advanced users who want to run the control on their 

own designs or machines of other manufacturers, refer to the Reference Manual, which describes 

parameter setting and macro programming. 
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1  General Information  

The present control software was designed on the basis of all common at the time of development 

and known guidelines and was very elaborate and carefully tested. Nevertheless, a guarantee for 

faultless function cannot be given. The developers guarantee that the KinetiC-NC control, in 

conjunction with suitable electrical and mechanical components in the sense of the description and 

user instructions, is basically suitable for the intended purpose. 

 

Liability 

Any liability for consequential damage or loss of profit, interruption of business, loss of information 

etc. is excluded. The KinetiC-NC control software is a component that can only be used in 

conjunction with a suitable personal computer and suitable hardware. It is by no means an 

independent controller. 

Since mistakes, despite all efforts, can never be completely avoided, we are grateful for any note. 

 

The user guides 

Since not all users need all the information about the control hardware and software, the 

documentation has been divided into several manuals. For hardware and wiring information, refer 

to the manuals for each hardware module. The software installation guide and general operating 

instructions are included in the KinetiC-NC User Guide. 

The Reference Manual is intended for the advanced user who programs NC programs or macros 

"by hand" or for machine builders who need to adapt the controller to a new machine. 

 

Manufacturer: 

Benezan Electronics 

Stauffenbergstraße 26 

72108 Rottenburg 

Germany 

 

Distribution: 

CNC-STEP GmbH & Co. KG 

Siemensstraße 13-15 

47608 Geldern 

Germany 

  

http://benezan-electronics.de/
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 Icon descript ion  

 

 

NOTE: Special information regarding the economic use of the system 

 

ATTENTION: Special information or rules and prohibitions for damage prevention. 

 

Statements or prohibitions on the prevention of personal injury or extensive 

property damage. 

 

 Safety  instruct ions  

CNC machining always carries a certain risk of injury, because it works with fast rotating 

tools with sharp edges. Due to the computer-controlled movement of the drives, machine 

parts can unexpectedly start to move for the operator. Although the control software has 

been carefully tested, malfunctions can occur at any time. Therefore, follow the instructions 

of the machine manufacturer exactly. Never operate the machine without the prescribed safety 

devices. The plant operator is responsible for compliance with the statutory accident prevention 

regulations. 

 

 

 Safety  symbols  
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 System Requirements  

To operate the CncPOD and KinetiC-NC control software, you need at least the following 

equipment: 

 

• A PC with Windows operating system (XP, Windows7 or later), laptops, netbooks or similar 

devices are not recommended 

• At least 1GHz processor frequency, min. 1GB of RAM and 2GB of free hard disk space 

• A graphics card (or onboard chipset) with 3D hardware acceleration 

• A network interface according to IEEE802.3 with min. 10MBit (10Base-T), if the network 

is also to be used for file, internet or other services, min. 100MBit (100Base-TX) and 

additionally a network switch or a second interface 

• A 5V power adapter with mini USB cable 

• A CNC milling machine or engraving machine with stepper motor drives or servos with step 

/ direction signals and associated control electronics (e.g. Zero 3) 

• A network cable (Cat 5 or 6) with RJ45 connectors for connecting the CncPOD to the PC 

• One SUBD-25 cable (male to female) to connect the CncPOD to the stepper motor 

controller 

 

 

 Real- t ime  requirements   

In order for the PC to be used as a control computer, it must be "real-time capable" to a 

limited extent, i.e. can respond reliably to signals from the machine within the shortest 

possible reaction time. With KinetiC-NC control, all time-critical signals are generated 

with external hardware - the CncPod - instead of directly with the PC. The requirements are 

therefore not as high as with a CNC software without hardware support such as Mach3 with 

operation via the PC's internal LPT port. Nevertheless, a few things should be considered to ensure 

a smooth working environment. 
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Desktop PC or laptop? 

As a control computer, if possible, a desktop PC or similar device (industrial, panel or box PC) 

should be used and no laptop or similar portable, battery-powered device. Although laptops tend to 

have decent processing power these days, they are designed for low power consumption. 

Unexpectedly switching to energy-saving mode may result in sudden program delays. It requires a 

good knowledge of the operating system to disable all energy-saving options, and to make a 

portable device operational for CNC operation. 

 

Virus Scanner 

Another problem can be virus scanners or automatic updates, which are started automatically at a 

certain time, and cause sudden network load or changes to the operating system. While surfing the 

Internet or transferring files on the corporate network itself does not interfere with CNC operation, 

the background actions of an anti-virus program that it causes can cause problems. It is therefore 

recommended to disable problematic programs such as virus scanners, expensive screen savers and 

the like, and to refrain from surfing the Internet while the CNC machine is running. 

 

No step losses 

Nevertheless, if an unexpected delay should occur, this will not be a problem for the KinetiC-NC 

controller. While with other programs such as Mach3 even a delay of a few microseconds can have 

fatal consequences (step losses, possible collisions), the machine with the KinetiC-NC simply stops 

briefly (with the correct braking ramp, of course) and drives normally once the problem has been 

resolved. This is usually harmless but can still lead to unwanted effects in certain cases (chatter 

marks in case of metal or burns in woodworking or plasma cutting). 
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2  Instal lation of „CncPOD“  

The following description of the installation procedure assumes that the machine and the rest of the 

electronics (PC and Zero3 control, for example) are already operational. 

 

 Power supply   

The CncPod requires a 5V power supply with USB port for power supply. To connect the power 

supply to the CncPOD, a USB cable with a mini-USB connector is used. Please always use an extra 

power adapter, and do not connect the CncPOD to the PC with a USB cable. Although this also 

works for test purposes, the galvanic isolation of the network connection would be ineffective, 

making the controller unnecessarily susceptible to electromagnetic interference. The USB port is for 

power only. A data transfer with USB is not provided. 

 

 LPT-Ports  

A 25-pin SUB-D cable connects the CncPod to the machine's control electronics (Zero3 or Raptor 

cabinet, for example). At port 1, the step signals of the first 4 axes and the switch and relay signals 

are available. At port 2, extensions such as Tool changer, frequency converter or a laser module can 

be connected. 
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 Network connect ion 

The CncPod is connected to the PC via 

the network connection for data 

transmission. Unlike competitor 

products, you do not need a dedicated PC 

port, so you do not need to install a 

second network card in the PC, but you 

can use the existing network 

infrastructure, and you can also share the 

CncPOD with other devices on a 

network. Connect switch. If there is a 

larger home or office network with 

multiple PCs, the following rules should 

be followed to avoid bottlenecks: 

 

• The connection to the PC should 

always have the fastest 

transmission rate in the network. 

So if the PC has a GBit interface 

and the DSL router only 

100MBit, then the switch should 

also 1GBit, and the CncPOD be 

connected directly to this switch. 

This ensures that there is no 

bottleneck, and data transfer 

between other PCs does not slow 

down communication with the 

CncPod. 

 

• Only "unmanaged switches" may be used. Routers with "intelligent" functions (firewalls, 

proxy ...) that filter logs do not work. Of course, this only applies to the connection path 

from the control PC to the CncPod. Outside this route, any devices may be connected to the 

network. 

 

• Wireless connections are not supported, as well as modems or external USB network 

adapters that "tunnel" Ethernet over other protocols and are associated with time delays. 

(This again applies only to the PC to CncPOD link) 
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Windows 8 and 10, and especially portable devices, may experience problems because the 

operating system shuts off the network connection after a few minutes of inactivity (sleep mode). 

This can be prevented if the CncPod is connected via a switch even if it is the only device. 

 

The second switch on the penultimate picture on the right is therefore permitted because 

only devices of the CNC machine are connected to it. Thus, the connection between the 

two switches cannot be overloaded by foreign traffic and become a bottleneck. 

 

 

As already described in the chapter "System requirements - Real-time requirements", it is very 

important for the control computer that sufficient computing power is available at all times, and the 

PC is not slowed down by background programs. Therefore, you should make sure, 

 

• to remove all unnecessary programs 

• to disable automatic updates 

• If it is a laptop (expressly not recommended), always power the device and disable all 

energy-saving options 

• Not to use a virus scanner. If this is unavoidable, make sure the KinetiC-NC software's anti-

virus software grants free access to the network interface and does not perform any 

elaborate scans while the machine is running. 

• During the installation (especially with WinPcap) prompts may come through the firewall or 

the virus scanner. In any case, you must allow access. 
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3  Instal lation Software  

Starting the Installation 

The software is usually delivered on a CD or a USB stick. When you insert the CD into the drive, 

the installation starts automatically. For a USB stick or if the automatic start does not work, or you 

have downloaded the software from the Internet, please start the program "KinetiC-NC_Setup.exe" 

manually. 

 

After starting the setup program, you will be prompted to select the 

language of the installation wizard. Confirm your selection with OK. 

(Depends on the language of your Windows OS this first dialog can be in a 

different language)  

 

 

 Instal lat ion WinPCAP 

You will first be prompted to install "WinPCAP". This is a 

kind of universal driver software for network controllers 

and is required for communication of the KinetiC-NC 

software with the CncPod. 

 

Start the installation of WinPcap by pressing the "Next>" 

button. 

 

 

 

 License  condit ions  

You must agree to the license terms of the WinPcap software by pressing the "I Agree" button to 

continue the installation. 

Please make sure the tick in the box is checked (as in the picture above). If this is not the case, the 

KinetiC-NC software will not work properly. 

 

You have successfully completed the installation of WinPcap. Confirm this with the button 

"Finish". 

Continue the installation by confirming the "Next" button. 

 

After having read and understood the license agreement, you accept it by ticking the option "I 

accept the agreement" and confirm with the "Next" button. 
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 Instal lat ion main program KinetiC-NC 

In the following dialog you can select the type of 

installation. It is recommended not to change the settings. 

However, if you would like to contribute to the further 

development of the program and speak a native language 

that is not yet supported, you may also like to install the 

language support. This allows you to create your own 

translations of the software and share it with other users. 

 

 

 

The KinetiC-NC software is installed in the suggested 

folder. 

If you would like to rename the entry, you can do so now. 

 

 

 

 

 

 

 

By ticking the box, you can install an icon on the desktop to 

quickly start the software. 

 

The installer is now fully configured, and you are ready to 

install the software. 
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 Instal l  Updates  

If you are updating an existing installation, you may be asked if existing files should be overwritten. 

Select "No" if you want to keep existing settings or "Yes" if you want to reset all parameters to the 

factory settings. 

 

Although normally no settings (unsolicited) are overwritten when installing an update, it is strongly 

advised to back up the machine parameters before each update. This ensures that you can return to 

the old state in the event that something does not work as expected. 

 

After completing the installation wizard, there will be a new "KinetiC-NC" entry in the Windows 

Start menu and, if selected, an icon on the desktop. 
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4  Initial  Start-up  

The first time you start the software, you will be asked for the language first .  

 

Then a list of known machines is displayed, for which there are already predefined parameter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 User  information  

During the first start of the software its necessary to enter the user details. This can be important if 

you need support or you want to add additional options. 
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 Machine Select ion ->  Plug & Play  

If you purchased the software together with a machine, chose the machine type that best suits yours. 

Later, you will no longer need to perform any manual parameter settings, except perhaps to install 

additional purchased options. 

 

If your machine does not match any of the models in the list, please select "CncPod Default 

Settings". You then have to enter at least the most important parameters such as travel distances, 

maximum speeds and resolutions of the axes themselves. For special machines or self-construction, 

refer to the optional Reference Manual for Advanced Users, as the detailed description of all setting 

options would go beyond the scope of this manual. In the following, only the most important 

features are explained. 

 

After selecting the machine model, the main window of 

the software opens. It is usually recommended  to always 

turn on the machine before starting the software. If this 

has not already been done or there are problems with the 

connection, the following dialog appears: 

 

 

 

Turn the machine on and click on the button "Scan 

Network". The hardware selection dialog will then 

appear as shown on the bottom right. This is necessary 

because the CncPod does not have an "exclusive" port 

but shares the infrastructure of the possibly larger 

computer network. It is possible that several machines 

are connected in a network, or that a machine in addition 

to the CncPod also uses other hardware modules. Each 

module has a unique number (MAC address), so that the 

software can remember the assignment of "its" modules. 
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If everything is connected correctly, in the upper part of the window under "detected hardware 

(unused)" the CncPod with a number similar to the one in the picture should be displayed. If 

nothing is displayed there, check that the CncPod with the network cable is properly connected to 

the PC and is powered by the USB power supply. At least the right, green LED on the network 

connection of the CncPOD should light up (connection status). With "Search net" you can redisplay 

the list. If several CncPODs are listed, which can be found on several existing machines in a larger 

network, you can use "Identification" to find out which one is the right one. The currently selected 

CncPOD is to be recognized by its flashing left, yellow Traffic LED. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Establ ish  connect ion  

After selecting CncPod in the list, you can connect using "connect". The CncPOD is then displayed 

in the lower part under "Connected hardware (used)". 
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 Demo mode 

As long as the bottom list is empty, the software can only be run in demo mode. In this case, you 

can try almost all the features of the software, but it will not do any machine movement, just 

simulate it on the screen. Of course, a hardware should be connected for the subsequent 

commissioning, and the demo mode should be deactivated. 

 

As the software evolves, you may be prompted to update the firmware when you connect the 

hardware. This means that the software, which is stored in the processor of the hardware module, 

must be adapted to the state of the PC software. If you are asked to do so, please follow the 

instructions in chapter "Updating the machine firmware". 

 

The installation is now complete, and you can log in for the first time. 

 

 User  login 

Not all functions of the software are allowed at any time. It may happen that certain buttons and 

menu items are locked. In the picture below, for example, the machine movement, spindle and 

coolant function and tool change and homing are disabled ("grayed out"). 

 

All machine movements are of course blocked as long as the emergency stop is active. Regardless 

of the condition of the machine, there is another reason why functions may be limited. 
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 No access?  

If you do not have access to certain buttons or menu items, make sure which user you are currently 

logged in with. This is indicated in the status bar at the bottom of the main window (e.g., "User: 

Default User"). If there is "User: logged off", you must first log in to have access to machine 

functions. 

 

To do this, open the login dialog via the menu-> user-> login ... A small dialog opens in which the 

desired user can be selected. In the Password field, the corresponding password is entered and 

confirmed with "Enter". 

 

The default user has sufficient rights to work with the machine. By default, he has not given a 

password, so you just have to confirm with "Enter" to close the dialog and log in. Users without a 

password will automatically be logged in the next time the program starts without the dialog 

opening. The default user may not change any settings and machine parameters. The user "Client-

Admin" has the beginning password "1234". This administrator has the right to change machine 

settings. On request, users can be assigned passwords to protect the machine against misuse (see 

chapter User management). 

 

If you leave the workplace without switching off the machine, you can also log out for security 

reasons by clicking "Menu-> User-> Logout ...". 

The user is then logged off and the machine can no longer be operated. 

 

 Parameter sett ings  

If you purchased the software together with a finished machine and selected the appropriate model 

as described above when you first started the software, no further parameter setting is required, and 

you can skip this chapter. 

In case you have made a mistake in the selection, or you want to adapt the software later to another 

machine, you can also undo the selection and load the parameter set for another machine model. 

Open the import dialog (File menu -> Import settings) and then the file selection dialog by pressing 

the "Default parameter ..." button. 
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 Individual  adaptat ion  

If your machine does not meet the standard parameters, you must now enter the parameters 

manually. If you have not received information from the manufacturer of the machine, contact 

support or (only if you are really comfortable with it) follow the instructions in the Controller 

Reference Manual. 

 

 Function control  

In the main window, switch to the "Diagnostics" page. First, you should test the function 

of the emergency stop button. When the switch is pressed, the symbol with the red / yellow 

button labelled "Emergency Stop" must appear on the right in the "Status" field. After 

unlocking the switch, it must disappear and an "OK" symbol will appear. If your machine 

has security doors or a high frequency spindle with a frequency converter, other symbols may appear 

depending on their condition. 
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If the DEMO symbol appears instead, there is (still) no connection to the hardware. 

Please check this in the menu "Configuration -> Hardware". The symbol with the plug 

drawn on the far right indicates that a connection existed but was subsequently 

disconnected. This may not only be due to the cable connection itself but also to the operating 

system (anti-virus, firewall, energy-saving mode, see also chapter "Installing the CncPOD"). 

 

The triangular warning labels indicate a problem with the safety door, the frequency converter or 

other external equipment. For information about how to resolve the issues in these cases, refer to 

the instructions in the appropriate extension. If the "Emergency Stop" symbol does not disappear, 

check whether all emergency stop switches are actually unlocked and whether all connections to the 

controller and machine are plugged in correctly. 

 

If the lists of inputs and outputs on the diagnostics page (large picture above) are empty, this can be 

remedied by resetting the input / output pin assignment. The default assignment of the inputs and 

outputs can be restored with Menu -> File -> Import Settings by selecting the default parameters, 

deactivating all check marks except "Inputs / Outputs" and then loading with "Open". 
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 Reference  switch  

Next, please check the function of the reference switch. If the switches are not actuated, i.e. the axes 

are within the normal travel range, the indicator lights "Ref." On the diagnostics page must be off. 

You have to get started if you operate the switches by hand. For inductive switches you have to 

hold a piece of metal in front of the switch, for reed switches a magnet. 

Now it must be checked whether the directions of rotation of the drive motors are correct. 

 

Go to the page "Setup". When pressing the arrow buttons, the associated axis must move in the 

right direction. Depending on the position of the machine and the line of sight of the operator, the 

actual direction (front / rear, right / left) may differ from the direction of the arrows. However, the 

coordinate display counting mode must be up when the tool moves away from the home switch and 

vice versa. With the Z axis, the tool moves up, that is, away from the workpiece when the 

coordinate display counts up. 

 

 

 

 

 

 

 

 

 

 



 KinetiC-NC 

User Manual 

 

 

  

CNC-STEP GmbH & Co. KG ▪ Siemensstrasse 13-15 ▪ 47608 Geldern ▪ Germany Page 30 

Support: +49 (0)2831/91021-50 10.11.2018 

 

 

If a drive moves in the wrong direction, this can be corrected with "Inverted direction" in the axis 

parameters. 

 

If the reference switches are working and the directions of all drives are correct, you can start a 

homing run with the "All Ref" button on the diagnostics page. If you have to cancel the homing 

because there is still something wrong, you can either do this by pressing the button again or 

pressing the ESC key. 

 

 Test  outputs  

Finally, you can test the function of the spindle and coolant outlets (or dust extraction). To do this, 

click on the corresponding boxes in the "Outputs" field on the diagnostics page, e.g. "Spindle 

forward" or "coolant". 
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 Create backup 

After you have set all parameters, it is advisable to make a backup of the settings. In the 

event that data loss occurs due to damage to the PC, or you make erroneous changes, the 

original parameters can then be easily recovered, and you do not have to redo all settings.  

 

Details can be found in the chapter "The File Menu". 

 

 

 Instal lat ion of  addit ional  options  

If, in addition to the basic equipment, you have purchased additional options for your 

machine, it may be that the machine parameters deviate from the standard settings and 

must be supplemented. Please refer to the instructions in the option to see if this is 

required.  

 

In this case, a file is attached, or a link specified where you can 

download the file. You can import this file by selecting "Import 

settings" in the File menu.  

 

If you click on the button with the three dots to the right of the file 

name, you can select the file. 
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Then press "Open" in the file selection 

dialog, and then again "Open" in the import 

dialog. Make sure that in the user 

management the rights to use such an 

additional option can be set separately for 

each user. 

 

 

 

 

 

 

 

 Firmware  Update  

As the software evolves, you may be prompted to update the firmware when you connect the 

hardware. This means that the software, which is stored in the processor of the hardware module, 

must be adapted to the state of the PC software. This happens automatically. 

 

First open the hardware dialog via menu-> configuration-> hardware. 

 

The following dialog opens: 

 

The module to be updated must be in the upper part of the 

list. If this is not the case, but the module is in the lower 

part, as in the picture on the right, select the module and 

then confirm the "Disconnect" button. This disconnects 

the machine from the software and the module is placed 

in the top list as unused. 

 

Click on the button "Update" to start the update of the 

module. 
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In the upper part of the dialog box you can make sure once again whether you have also selected the 

correct module. Then select an update file by clicking on the button with the three dots. Choose the 

one with the highest version number that matches the hardware module unless you have received 

different instructions from support. 

 

 Are you sure?  

A warning message appears. Please read this carefully and only confirm with "yes" if you are 

absolutely sure that the connection cannot be interrupted during the update. In particular, never 

carry out updates with laptops, notebooks or other battery-powered devices, as these could 

unintentionally turn off the network connection (power-saving mode). 

 

During the update, do not turn off the 

machine or disconnect the network 

cable. This could irreparably damage 

the module. 

 

 

 

 

 

 

 

 Reconnect  

All you have to do is follow the instructions on the screen. After transferring the firmware file, it is 

important to wait until the alternating flashing of the CncPOD's LEDs stops. Only then restart the 

CNCPod by briefly disconnecting and reconnecting the power supply (USB). 

Now select the module again and connect it by confirming the button "Connect". 

After the hardware module is successfully connected, click on "Save" 

The hardware dialog closes and the message "Hardware connected: CncPod ..." should appear in the 

lower right part of the main window. 
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5  Short introduction  

This chapter explains the most important steps required to load and execute a CNC program in the 

"fast run". 

The design of the graphical interface of the software may differ from the design of the illustrations 

in this manual. It deliberately chose a "classic design" with few colors to optimize the contrast and 

readability of the manual. 

 

 Start ing the  Software  

It is best to turn on the machine before starting the software. Otherwise, you will receive an error 

message because it will automatically attempt to connect to the controller at startup. If you forgot to 

turn it on, you can easily make up for it and click "Retry" a few seconds later. 
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 Log in  as  a  user  

 

The software supports the ability to restrict access to functions depending on the logged in user. At 

the bottom of the screen in the middle of the status line you can see which user you are currently 

logged in with. As a logged-off user, you are not authorized to move the machine or start programs. 

The possibilities are very limited, which is also visible through the gray buttons and menus. 
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 Release  of  the  functions  

If certain functions are inaccessible (grayed out) after starting the software, there may be 

two causes: 

 

 

• The emergency stop of the machine is activated. This can be recognized by the symbol 

"Emergency Stop". No programs or movements can then be started, and no outputs can be 

switched on. If your machine has security doors or alarm signals from external devices, this 

may also lock machine functions. This is indicated by a different symbol instead of 

"Emergency Stop". Only with "OK" all functions are enabled. 

• No user is logged in or the current user is not authorized for certain functions.  

 

If "User logged out" is displayed in the status bar, or if you need 

to access functions that require special authorization, you must 

log in as the user. To do this, select in menu-> user-> login. 

 

 

Access to the machine parameters (Configuration - Machine menu) is e.g. only allowed to the 

administrator. You can log in as Administrator by selecting "Kunden-Admin". In the delivery state 

the password is "1234". The default user does not require a password. 
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 Distribution of  the screen  

To keep the screen as clear as possible, the main window is divided into four pages. The tabs at the 

top of the title and menu bar (Program, Setup, Diagnostics and Special) allow you to switch 

between the pages. The exact meaning of all individual elements is explained in detail in the chapter 

"The user interface". 
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 The coordinates  display  

Common to all four sides is the coordinate display (white numbers on a blue background, top 

right) and the text window in the bottom right for the messages. 

On the main page („Program“) is the graphic display on the top left, where after the start first the 

company logo appears. After loading the program, the tool path is displayed here. Underneath is the 

window for the program text, which is empty after the program starts. 

 

 Load f i l e  

 

At the top of the title bar is the menu bar. 

Select „File->Open NC file“, to open the file dialog. Select the sample file "Sample.din" or another 

G-code file of your choice. Depending on the Windows version, you will find the example files in 

the folder "My Documents\KinetiC-NC" or "Libraries\Documents\KinetiC-NC". 

 

If you have ever opened a file, you can open it again from the list of recently used files. 
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 Errors  

The program will now be displayed on the main page ("Program") in the text window at the bottom 

left. In the graphics window on the top left, the tool path appears, if it fits into the editing room. If 

not, or if other errors have been detected, an error message appears in the message window at the 

bottom right.  

 

For example, it may indicate that "number out of range ..." is displayed because the zero point is not 

yet in the correct location and parts of the tool path are outside of the processing space. It is 

important to recognize this already before the machine would hit a stop during machining. 

 

 The 3D display  

Above the NC program, the working area of the machine is displayed. 
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6  The operation  

By dragging the mouse pointer while holding 

down the left key in the graphics window, you 

can move the tool path. 

While keeping the right mouse button pressed, 

they spin the path in the room, which means 

they change the viewing angle to the 3D display. 

Turn the mouse wheel to zoom in or zoom out. 

By double-clicking on the left mouse button, 

you can switch between the following display 

modes: 

 

• Zoom on the whole machine. The center of rotation is at the center of the machine 

• Zoom on the workpiece, the center of rotation is in the middle of the workpiece. 

 

 Set  zero point  

 Where  to  put  the  zero point  

Before a program can be started, it is necessary to tell the control software where the workpiece is 

located on the machine. This is done by setting the zero point. Where the zero point is on the 

workpiece depends on the drawing. The "Sample.din" file contains the zero point in the lower left 

corner and at the level of the drawing. For round or symmetrical parts, it may also be that the zero 

point is in the center. In the Z direction, the zero point is usually placed on the upper edge of the 

workpiece so that positive Z values are above the material, the negative ones indicate the 

penetration depth into the material. For some applications, it may also be useful to place the zero 

point on the bottom of the material, for example, to make the programs and settings regardless of 

the material thickness. 

The following description assumes that the zero point in the drawing is on top of the material. The 

topic will be discussed in more detail later. This example is only about basic understanding. 

 

 The start  up  

Switch to the "Setup" page, where the buttons with the arrows are located. 

 

Clamp a workpiece to practice on the machine's working surface, such as a wooden plate. Briefly 

press the arrow pointing to the right.  
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 Reference  moveme nt 

If no homing has been performed yet, a dialog with a warning appears. 

 

Select "Now Homing" to perform homing. Then use the arrow 

buttons in the X and Y direction so that the tool is above the 

workpiece.  

Now you can move the tool down until it is about 10mm 

above the top. Now the speed should be reduced.  

In the list of speeds, click "100.0 mm / min."  

 

Carefully continue to drive down until the tool is only about 

one millimeter from the workpiece. Reduce the speed further 

to 10 mm / min.  

Now put a piece of paper on the workpiece. Continue to drive 

slowly down until the paper stops moving and is clamped 

under the tool.  

Now press the "0" button next to the Z coordinate display. The 

coordinate jumps to zero. 

 

 

 Speed sett ing  

Set the speed back to 1000mm / min and drive Z up a few 

millimeters. Now you can use X and Y to move the tool over 

the left (X) lower (Y) corner, and also set these two axes to 

zero.  

Now the X and Y coordinates should be zero and the Z 

coordinate should be a few millimeters (positive). 

Be careful when approaching the workpiece, the machine table or any other object. You can cancel 

the movement at any time by releasing the button. With hard material and sensitive tools just a few 

1 / 100mm too much can lead to tool breakage. Therefore, it is best to use a workpiece made of 

flexible material such as wood or hard foam for practicing. 
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 The zero  point  symbol  

When a program is loaded, the graphic display is updated with the tool path each time the zero point 

is changed. The position of the zero point in the engine room is indicated by the "tripod" of three 

colored arrows. 

 

 Zero point  and material  

After the zero point is set correctly, the entire toolpath should 

be displayed in the graphics window, and no further error 

message will appear in the message window.  

 

Before running a program for the first time, it is advisable to 

set the feed factor ("feed override", slider in the middle, to the 

right of the graphic display) to approx. 10%.  

 

 

So, you have enough time to react if the machine does not run 

as intended, and a collision threatens. 

 

 

 

 

 

 Slow feed  

Set the slider "Feed" 10% and then press "Start Program"  on the far left. The machine starts 

moving and moves to the first letter "C". During the first pass the contour is driven 4mm above the 

material. If everything is correct, you can set the slider back to 100% or press the "Reset" button  

to the right of the slider. The machine now runs at the full, programmed speed, in the example 

500mm / min. On the second run Z = 0 is driven, just above the material. In a real milling job, of 

course, a negative Z value would be inscribed, this is just a demonstration. 

 

 Presentat ion of  the  path 

During execution, the already travelled distance in the graph is highlighted in light blue. You can let 

the program through to the end, or at any time press with "program stop"  Cancel. "Rewind"

and return to the beginning of the program and also clear the display of the distance traveled. 
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7  The user interface  

The user interface is divided into 4 clear screen areas and the menu at the top of the screen. 

 

Simple it safer 

The design of these areas was deliberately chosen to be simple and to handle all functions while 

working on the machine. 

A consciously overcrowded and artistically playful surface has been deliberately omitted in order to 

offer the user a clear, clean structure in order to exclude the risk of operating errors due to 

confusion. 

 

 The program screen 

 

On the first page is the graphic display of the tool path, the text display of the NC program and the 

most important control elements to start and control the program sequence. 
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 Graphic  display  

In the upper left window, the tool and its path are displayed in 

three-dimensional space after an NC program has been loaded. 

 

The "tripod" with the red, green and blue arrow represents the 

position of the coordinate origin. Rapid traverse sections are shown 

in dashed red, milling paths with green lines (if several tools are 

used, possibly in different colors). 

 

 

 

 Mouse  operation  

After clicking with the left mouse button in the window, you can: 

Move the display up / down and left / right by dragging the mouse while holding down the button. 

• Use the mouse wheel to move closer or farther away from the subject (zoom). 

• Dragging while holding down the right mouse button turns the viewing angle. 

• Double-click with the left mouse button to center the object in the window and set the 

center of rotation in the workpiece, double-click sets the zoom so that the complete machine 

room is displayed, which is represented by a cuboid of thin, gray lines. Also, the center of 

rotation is set in the middle of the working space. 

• Double-clicking with the right mouse button opens a small menu.  

 

 

The "Machine" option displays the 

working space graphically. If this 

option is deselected, only the 

workpiece (if a program is loaded) and 

the zero point are displayed. The 

"Simple Machine" option draws the 

workspace as thin, gray lines. If this 

option is deselected, the machine 

workspace is displayed as a 

checkerboard pattern. 
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 The NC program window  

Below the graphics window is the text display for the NC program. 

In the window you can scroll with the mouse or the cursor keys to look at the whole 

program or to go to a certain line. 

If you click on a certain line, the button "Start from here"   will activate and you can continue a 

program from this point. 

 

 The control  e lements  

Below, the other controls are briefly explained. If one of the icons should later be unclear, you can 

leave a short help text ("Tooltip") by leaving the mouse pointer over the button. 

First the display of the symbols is explained by the "Edit" -button: 

 

Normal, active button that can be pressed. 

 

 

Normal, active button that can be pressed, which has the current focus. 

 

  

Currently pressed button. 

  

 

Disabled button that cannot be pressed. Cause can be missing user rights, or the function 

is currently not possible. 
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7 .1 .4 .1  The symbols  in  detai l  

  

Program start, this will start the currently loaded program. 

 

 

Program start from currently selected line. This can be used to resume a program, which 

previously was e.g. was cancelled. 

 

 

Stop the program. This will stop the currently running program.  

 

 

Rewind the program. With this button you are right back at the beginning of the first 

line of the program. 

 

 

Load program. This button is identical to Menu-> File-> Open NC File 

 

 

Edit program. This button opens an editor in which the current NC program can be 

edited. 

 

Sets the coordinate to the right to zero (0). The coordinate refers to the selected, current 

offset (G53-G59) 

 

 

 Sets all coordinates to zero (0). The coordinates refer to the selected, current offset 

(G53-G59) 

 

  

Carries out a homing run with all axes. 

 

 

 Opens the MDI input line. This allows individual G commands to be executed, e.g. 

G0X100 to move the X-axis to position 100. 

 

 Activates or deactivates the tool length compensation G49. 
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 The feeds  

In the upper right column are the feed override sliders (feed%) and the spindle speed override 

(spindle%). This allows you to change the execution speed between 0 (standstill) and 150% or the 

spindle speed (if your machine has a spindle with frequency converter) while the program is 

running. 

 

  

With these buttons you can change the current feed. 

 

 

With the ESC key, you can immediately zero the feed override to temporarily stop program 

execution. This has the same effect as zeroing the feed slider. The button "Reset" resumes execution 

at normal speed (100%). To indicate the cause for the standstill more conspicuously, the field is 

colored red at 0% feed. 

 

 These buttons can be used to change the spindle speed. 

 

 

 

 

 

 

 

These buttons decrease or increase the set jog speed, which is shown in the display between these 

buttons. 

 

 Tools  and track sett ings  

 
 

  

Opens the tool change dialog. 

 

 

 Opens a window in which many settings for the machining strategy can be changed. See 

Tool-Path-Settings. 
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 Outputs  and tool  spindle  

Switches the tool spindle in the corresponding direction of rotation. 

Depending on the machine type, only one of these buttons may be displayed. 

  

 

Turn on flood or spray cooling. Depending on the machine type, it may be that 

only one of the two types of cooling exists. 

 

 The coordinates  display  

In the middle column, the coordinate displays are located at the top, where the positions of the axes 

are displayed. The position values always refer to the current zero point, which can be selected with 

the selection button below.  

 

 Offsets  

For G53 the coordinates are absolute (machine zero) and are shown in white on green, all other 

choices are workpiece related offsets and are displayed in white on blue. All workpiece offsets G54 

to G59 are permanently stored on the hard disk of the computer and are retained even after the 

software has been exited and restarted. 

 

 

 Set  the coordinates  

By double-clicking with the left mouse button on a number, a coordinate 

can be entered manually. The selection "relative" means that the number 

input is added to the current coordinate.  

 

For example, the coordinate Z is currently at a value of 50,000. A manual input of 30,000 would set 

the coordinate to a value of 30,000, and if the option "relative" would be used, an input of 30,000 

would set the coordinate to a value of 80,000. 
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 Feed and Speed display  

Under the spindle speed and feed controller, the current spindle speed (S) 

and the current feed speed (F) are also displayed. These are usually 

displayed in white on blue. If the option "Replace F / S global" is selected 

in the, these are displayed in white on turquoise. 

 

 

 

 

 Emergency  stop and alarm  

Right, below the coordinate display is the status display. 

 

When the machine is running or ready for movement or program execution, an OK icon will appear 

there. When the emergency stop button is pressed, the hardware is not plugged in or powered down, 

or another fault condition is present, the "Emergency Stop" - or other warning icon will appear. 

 

If the DEMO symbol appears, there is no connection to the hardware. The triangular warning labels 

indicate a problem with the safety door, the frequency converter or other external equipment. 

 

For information about how to resolve the issues in these 

cases, refer to the instructions in the appropriate 

extension. 

 

 

 

Attention: The emergency stop symbol is only an indication. You cannot trigger an 

emergency stop by clicking on the symbol. This was deliberately done because a 

software-triggered halt is not secure, and valuable seconds are lost in an emergency, 

because searching with the mouse pointer takes much too long. In case of imminent danger please 

use the "real" emergency stop switch on the machine or on the control. 

 

 

 

 

 

 



 KinetiC-NC 

User Manual 

 

 

  

CNC-STEP GmbH & Co. KG ▪ Siemensstrasse 13-15 ▪ 47608 Geldern ▪ Germany Page 50 

Support: +49 (0)2831/91021-50 10.11.2018 

 

 Message window  

The "Messages" window at the bottom right shows information about the program flow or error 

messages. The messages can be deleted by right-clicking on the window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 KinetiC-NC 

User Manual 

 

 

  

CNC-STEP GmbH & Co. KG ▪ Siemensstrasse 13-15 ▪ 47608 Geldern ▪ Germany Page 51 

Support: +49 (0)2831/91021-50 10.11.2018 

 

 The setup screen  

 

 The jog buttons  

This page is intended for setup. Just as with the program page, there is the coordinate display on the 

right, the message texts in the bottom right corner and the emergency stop display in the middle. 

Instead of the program text and graphics window, however, controls for manually moving the axes 

(jog) are available. The buttons with the arrows start directly a drive of the associated axis in the 

appropriate direction. The speed and step size can be selected using the selection buttons below. 

"Continuous" means the axis is moving as long as the arrow button is pressed and stops when 

released. For finite step sizes, and when "Position rounding" is active, the axis travels a maximum 

until the next position value rounded to the step size (with increments of "10mm", the axis travels a 

maximum of, for example, 481 to 490mm). The arrow button still has to be pressed for the axis to 

move, or in other words, if you release the button before the step size expires, the axis will stop 

immediately. This is to prevent a collision, if one has misjudged the free distance. 
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 Rounding  

If "Position rounding" is not active, the maximum distance travelled is the selected distance 

beginning with the start position, for example, with increments of 10mm from 481 to 491mm. In the 

input field directly under "step size", any number can be entered that is not in the list, eg 3mm. 

Incidentally, the axes can always be moved manually at any time, as long as no program is running, 

if you are on another page, using the hotkeys. By default, these are the arrow keys on the keypad of 

the keyboard. The buttons on the Setup page, however, give you better control over the speed and 

can, for example, gently touch the edges of the workpiece in small increments. 

 

 Zeroing display  

With the zero buttons next to the coordinates or by entering a number after double-clicking on the 

coordinate, you can again change the workpiece zero point. By clicking on the buttons "to park 

position" and "to zero point" on the left side under the arrow buttons, the machine moves directly to 

the zero point or the parking position. If you want the Z-height to remain constant, you can also 

choose "only X + Y" instead of "all axes". Attention use this function only if you are sure that the 

way to it is free! If a collision threatens, you can stop the movement by pressing the button again, or 

of course with the emergency stop button. 

 

 The MDI  

The "MDI" button at the top center opens a window with a 

text entry field. Here you can enter G-code commands 

directly. This can be useful for approaching certain 

locations or entering commands that enable a particular 

mode or function. 

If a G-command has been typed in and confirmed, it can be aborted by pressing the "Stop MDI 

command" button. 

While a command is being processed, 

the next command can be typed. This will be executed immediately after the previous command has 

been completed. 

 

Repeat 

By using the cursor keys up, you can scroll through the list of already entered commands to repeat 

faster and safer commands. 

 

 Attention, it is explicitly warned against misusing the MDI input to type programs in 

"real time". Too easily mistype it and risk a collision. Pay close attention to what you 

typed in and prefer to check it again before pressing Enter, especially on G0 commands. 
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 Soft l imi ts  

By default, the soft limits are always on, that is, after homing has been performed, the machine 

"knows" where it stands and how long the axes travel. It is therefore automatically always stopped 

before the hitting the stopping point. If the tick is removed before "Soft Limits", this check is 

switched off, which is normally only required when testing the machine, if the reference switches 

do not (yet) function properly. With soft limits off, you should only drive slowly and carefully. If 

the check mark is greyed out, deactivating the soft limits is prohibited (see Machine Configuration 

Dialog: Security - Force Soft Limits) 
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 The diagnost ic  screen  

In addition to the known coordinate display and the message window, the status of the inputs and 

outputs are displayed on this page. The states of the reference and (if present) limit switches are 

visible as signal lamps at the top center. To the left of the coordinate display are buttons for 

triggering a reference run. Either the selected axis or all axes one after the other move slowly to 

their reference switch to find the position of the zero point. 
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 Inputs  and outputs  

At the bottom left are the lists with the inputs and outputs. Only signals that are actually assigned to 

a hardware pin are displayed. A set tick corresponds to an "active" input, eg a depressed switch, or 

an appropriate statement (air pressure is OK, drive is ready, etc.). "Active" does not necessarily 

have anything to do with the voltage level at the input, because inputs can also be inverted 

depending on the switch type (NC or NO). For the outputs, on the other hand, an existing tick 

always means "on" and "voltage present", a missing "off" and "no voltage". Outputs must not be 

inverted because otherwise the safe state (switched off) would not be clearly defined. 

 

By clicking on the checkmarks of the outputs, they can be switched on and off. 

Regarding the entrances, a click logically does nothing. The PWM output can be tested 

by double-clicking. It then opens a small dialog box with a slider. Please use the test 

function with care, switching outputs may cause machine parts to move. 

 

 Lookahead-display  

The bar of the lookahead buffer indicates the level of the command buffer in CncPod. This allows 

conclusions about the quality of the network connection and the computing load of the PC. When 

driving longer distances, the display should be in the upper quarter (i.e., bar to almost far right). If 

the buffer runs low because the connection is bad, or if the PC is slowed down by other, 

computationally intensive programs, the movement of the machine may stall. Although this does 

not lead to a loss of position, because the CncPod initiates a normal braking and acceleration ramp 

in this case, and then continues normally. Depending on the type of processing, unwanted effects 

may nevertheless occur, such as e.g. Chatter marks during milling or burns during plasma or laser 

cutting. In the case of deliberate waiting times (G4) or transition from rapid traverse (G0) to 

processing (G1 to G3), it is normal for the buffer to be almost empty for a short time. 

 

 Hour meter  

The operating hour meter and the user clock show the time for how long the machine has been 

running.  

 

 Part  counter  

The part counter indicates the number of complete program executions. The user clock and the parts 

counter can be set to zero if required, the operating hours counter not. 
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 The special  screen  

Using the so-called user macros own functions can be realized, which are not predetermined by the 

software itself. You can either program the macros yourself by selecting the user macros at the 

bottom of the list in the Macro dialog (Configuration -> Macros menu). 

Or you can install macros using the import function (menu File -> Import Settings) downloaded 

from the Internet or supplied with a machine accessory. 

 

 
 

 Applicat ion examples  

Typical application examples for user macros are: Spindle warm up, tool length measurement with 

mobile probe, borehole center finding and much more. A more detailed description of the Macro-

programming language can be found in the separate reference manual. 
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8  The fi le  menu  

The following chapter explains the individual elements of the menu. 

The main menu is divided into the following individual areas: 

 

 

 

 Opening NC-fi le  

This opens a file selection dialog for loading an NC program. Alternatively, this can also be done 

with the "Load Program" button, which is located under the graphics window on the program page. 

 

 File  extensions  

The file must contain G code according to DIN / ISO and usually has one of the endings 

".din", ".iso", ".nc", ".tap", ".txt". G code contains the coordinates of the actual tool path 

and additional commands, such as tool spindle and coolant. Drawings created with a 

CAD program, on the other hand, contain only contours or areas or volumes of the workpieces and 

no information about the tool path. 3D drawings must first be edited with a CAM program to create 

the tool path. 2D drawings can be loaded with the Import Drawing function with certain 

restrictions. 
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 Error whi le  opening  

 
 

After selecting the file, it is loaded and the tool path is displayed in the 

graphics window. If errors are detected, the structure of the tool path is 

aborted at this point and a message is displayed in the lower right text 

window. The most common error is a "number out of range", which is 

usually due to a false or not yet set zero point. In this case, either select 

the correct zero point (G54 to G59) below the coordinate display or set 

a new zero point. 

 

The location of the zero point may e.g. can be changed by moving the 

axis to the correct position using the arrow keys (Setup page) and 

pressing the zero button next to the corresponding coordinate display. 

Alternatively, you can double-click on the Coordinate display and enter 

a number if you need a specific offset measure. 

 

 Recently  used f i les  

It often happens that you want to reload files that you have already used before. So that you do not 

have to remember the file names and enter them again, this submenu displays the last ten files used. 
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 Create NC f i le  

After selecting the location and entering a file name, the text editor opens and you can write an NC 

program by hand. The automatic coloring of the keywords leads to a clearer presentation and makes 

it easier to find typos. 

 

"Save" saves the program on the data medium and automatically loads it as a preview in the 

graphics window. 

 

If you still want to change the program afterwards, you can return to the text editor via the 

Edit button. 
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 Import  drawing  

2D drawings that are in DXF or HPGL format can be imported using this function, that is means 

they are converted to a G-code file. This is useful for operations that do not require a CAM 

function, where the cutting width (cutter diameter) need not be considered, such as when engraving 

scripts where the lines of the drawing correspond to the web of the tool center. For all other 

machining operations, where the tool path has to be offset by the tool radius, as well as for the 3D 

machining, an external CAM program is necessary. 

 

 Detai led descript ion of  the  import  f i l ter  

Since the Importfilters sometimes offer quite extensive functions, they are dedicated to a separate 

chapter at the end of the manual. For example, it describes an  HPGL-Importfilter and a DXF-

Importfilter that are included in the standard version of this software. 

 

 Import  se tt ings  

With this function you can load the complete machine parameters 

and all settings of the software or parts thereof from an external 

file. This can happen for several purposes: 

 

• You want to undo changes and import a previously made 

backup. 

• You want to install an additional feature or an update or an 

extension. 

• You want to switch to another machine or another type of 

processing. 

• You want to adopt settings from another, identical machine. 

 

 

 

 

 Partia l  import  

The control software not only supports complete parameter sets, but also subsets thereof. For 

example, if you buy a rotary axis retrospectively for a 3-axis milling machine, the seller can supply 

a parameter file that only contains the parameters relevant for the rotary axis, ie resolution, speed 

and travels of the fourth axis. 

If you import this file, only these parameters will be changed. All previously made, other settings 

are retained. 
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 Restore a  bac kup 

The "Restore" button takes you to the directory of the backup copies in order to restore previously 

made backups.  

 

 Refurbishment  

If you want to rebuild a machine, or if you 

want to use a fresh kit from the 

manufacturer, go to "Standard parameters" 

and select your machine. With "Standard 

parameters" you get to the directory of the 

predefined parameter sets. Attention, 

importing one of these files overwrites all 

settings made with the default values. Only 

do this if you want to "reset" to the factory 

settings and, if necessary, make a backup 

beforehand (see below). 

 

 

 

 Instal l  options  

If you want to reinstall an option, insert the media with the options file that you have received to the 

product and open the file. 

If you want to install an option that is part of the standard scope of the software, open the "Default 

Parameters". 

The subdirectory "Addons" within the standard parameters contains parameter sets for extensions 

and additional options, such as tangential knife cutting. The parameters in "Addons" are subsets of 

the machine parameters and overwrite only the relevant parameters. All the rest stay on the old 

values. 

If you only want to load certain parts of a configuration without overwriting existing settings, just 

select the desired options and then press "Open". 

 

Attention! Before importing parameter files, make sure that they are suitable for your 

machine type. Incorrect machine parameters, for example, can cause drives to drive 

faster than expected and cause collisions. Therefore, carry out a test drive at low speed 

after every change of the machine parameters. 
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 Export  set t ings  

With the export function you can save machine parameters and other settings of the software in a 

file. As with the import, this can also serve several purposes: 

 

• You want to make a backup (backup copy) of the settings. This makes sense after the 

successful installation or before extensive changes to the settings. 

• You use the same machine for multiple types of processing (such as milling and plasma 

cutting) and want to keep the settings made for later use. 

• You want to transfer the settings made to another, identical machine. 

 

 Create backup  

For a backup, it makes sense to select all setting 

categories. When transferring to another 

machine, however, you should definitely omit 

the module addresses, because otherwise the 

other machine would no longer recognize its 

own hardware modules after the import. Of 

course, you can only select individual 

categories, such as tool list or offsets. 

 

The file is only saved when you exit the dialog 

shown on the right with "Save".  

 

 Select  f i le  

In the file dialog, which is opened with the button with the three dots, only the file name and 

storage location are selected. 

If you are in demo mode, you cannot select module addresses or I / O assignments because there is 

no hardware connected in this case. 
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 Create individual  configurations  

With the button "Create icon" you can create a link of the current machine parameters on the 

desktop. To do this, enter the desired name of your configuration on the left next to it. 

Clicking on the icon starts the software with this configuration. This is useful if you have multiple 

machine configurations and you want to select one at the start of the software. The software then 

starts directly with these settings without you having to select "import settings". 

 

 Exit  

This menu item terminates the program, which of course is only allowed when the machine is 

stopped, when no NC program is currently running. Otherwise, you will be asked to stop the 

running program first with "Stop program". The Close Window button on the top right has the same 

effect. 
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9  The configuration menu  

 

 Machine  

All parameters related to the machine are set here, such as number, resolutions and speeds of the 

axis drives, inputs and outputs, jog speeds and other settings. Explaining the meaning of all the 

parameters here is beyond the scope of this manual, and in most cases is not necessary because 

standard parameter sets are available for machines sold with the software. A brief introduction to 

the most important settings can be found in the chapter „Initial-Start-up“. For advanced users and 

designers of special machines or self-construction, please refer to the separately available 

Reference manual.  

It is recommended to make a backup of the parameters before making any changes (see “create 

backup", top). 
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 Offsets  

In the offset dialog, the zero offsets G54 to G59 

(workpiece zero points) and the parking position 

are managed.  

 

Top left is the list of offsets. The currently 

selected (clicked with the mouse) offset is 

highlighted, and its coordinates are displayed on 

the right. With the "activate" button, the selected 

offset can be activated, i.e. all subsequent 

programs use this offset, as long as a different 

offset is activated by a G53..G59 command. 

 

 

 

 

With the button "Current Position", the current position of the tool is entered in the coordinates of 

the currently selected offset. This has the same effect as pressing "All Zero" ("0 XYZ") next to the 

coordinate display in the main window. In other words, after the offset has been activated with the 

coordinates of the current position, the coordinate display in the main window indicates the relative 

position (X = 0 Y = 0 Z = 0 etc.). 

 

 Copy Offset  

The button "Current Offset" copies the coordinates of the active offset, which is marked with an 

asterisk "*" in the list, into the coordinates of the just selected offset, i.e. G56 to G54 in the example 

in the upper picture. 

If you accidentally set an offset to incorrect coordinates, you can select "Cancel". All offsets will 

then be restored as they were before the dialog was called. "Save" saves the changes. 
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 Tools  

 Do I  need a  tool  l i s t?  

Tool management is only required if you have an automatic tool changer or if you are working with 

tool radius compensation or length compensation (G41 / G42 or G43). If you load the tool 

manually, and only ever use one per program, you can always work with only one tool number 

(T1), and you do not need to create a tool list. 

 

 Radius  compensation and length compensation  

The image above shows the tool list with the most important parameters. Type and name are for 

convenience only. The T number is the number used to identify the tool in the G code. The P 

number is the number of the place in the tool magazine. This is only needed if an automatic tool 

changer is used where the T number is not the same as the location number. Diameter 1 (Dm 1) is 

the effective diameter of the main cutting edges and is also used for radius compensation (G41 / 

G42). Length 1 (L. 1) is the total length of the tool and is used for length compensation (G43). 

Depending on the tool type, a second diameter and a second length can be specified. This can be, 

for example, shaft diameter and cutting length. The secondary parameters are only used for the 

visualization and play no role in the program flow. 
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 Add new tools  

"Change" or "Add" opens the tool dialog (see picture below) with either the currently selected or a 

new tool. The type and parameters of the tool can be entered. Standing times and max. Speed is 

currently not used. The track color is used for the 3D graphics. If different colors are chosen, the 

paths of the tools can be better distinguished. 

 

 

 Assign names  

If "automatic" is activated, a name is automatically generated from the selected settings. You can 

also replace the tool name with your own input. 

 

 

 

  



 KinetiC-NC 

User Manual 

 

 

  

CNC-STEP GmbH & Co. KG ▪ Siemensstrasse 13-15 ▪ 47608 Geldern ▪ Germany Page 68 

Support: +49 (0)2831/91021-50 10.11.2018 

 

 Hardware  

The hardware dialog is used to link the PC software to the connected hardware, in this case the 

CNC module of the machine used. This is normally only required once and is described in the 

chapter „Initial commissioning “ 

Later, you only need the hardware dialog to restore the connection after a possible interruption, or if 

you later want to install expansion modules, have to replace a module due to a repair, or to switch to 

demo mode (operation without hardware). 

 

 Hotkeys  

The control software supports so-called "Hotkeys", which means that you can trigger certain 

functions via the keyboard and also determine which keys should be. By default, for example, the 

arrow keys of the numeric keypad for manual driving (jog) are allocated so that you can change the 

tool position at any time without having to change to the Setup-Page of the main window. So that 

machine movements are not triggered unintentionally while typing, all Hotkeys are deactivated 

while text input fields are selected. 

 

 Assign keys  

With the hotkey dialog the assignment of the keys can be changed. Since not all keys are assigned 

to a visible character, the assignment takes place via a "key code", which is difficult to remember, 

which is why there is a learning function. First select a function in the list on the left and set the 

function top right from "not occupied" to "keyboard". If the "learn" button is pressed, the code of 

the next key press is automatically determined and entered. 
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 Jog-keys  

For the manual drive (jog) there are a lot of possible key assignments, because there is not only one 

button for each direction, but also several options for the speed. The functions without speed 

indication leave the speed at the last set value. The functions with (fast or slow) influence the speed. 

For example, you can set the keys so that an arrow key without a shift key moves at the currently 

set speed, the same key moves in rapid traverse with the shift key, and the same key moves slowly 

again together with the CTRL key. 

 

 Macros   

The controller can be flexibly adapted to different 

machines by programming so-called macros.  

Macros are small programs written in an extended G-

Code programing language and executed whenever 

special commands such as automatic tool change  

(M6) are executed.  

 

The macro defines the behaviour of the controller for 

these commands. In addition, there are macros that are 

always executed at certain times or events for example 

the startup macro when starting the control software. 

 

 

 

 

 Macro directory  

If you want to change the machine or the type of processing, changing the macro directory makes it 

easy to toggle between two or more sets of macros without having to change all the macros one at a 

time. By pressing the "Change" button on the right, a text editor is started and you can edit the 

program text of a single macro. This is recommended only for advanced users and is described in 

the separate reference manual. 
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 User 

Logging in users is required to gain access to certain functions. This is described in  „User-Login“ 

and "Login". This chapter explains the assignment of user rights and passwords. Of course, to be 

able to change user rights and passwords, you must have the corresponding rights, normally logged 

in as an administrator. 

 

After selecting the currently used user, the "Change password" button becomes active. Pressing this 

button opens a small dialog that allows you to enter a password. After entering the current password 

(which can be empty if no password was assigned) you can assign a new password. 

 

 Which password?  

Both inputs must be identical in order to prevent the password from being changed if it is mistyped. 

All numbers, letters and special characters are allowed, the password may be between 0 and 255 

characters long. This means that the field may also be empty, which means there is no password 

assigned. If you are the only user on the machine, it may make sense not to assign a password. So 

you do not have to log in every time. However, if other persons have access to the machine, it 

makes sense to block access to prevent unauthorized manipulation. 

 

 Forgot  Password  

Attention! Be careful not to forget the password. If this has happened, only an 

administrator can reset the password. 

If this is necessary or if you need to make further adjustments to the machine, please 

contact the  support of CNC-STEP GmbH & Co. KG. 

 

 Language  

Here you can change the language later. The change does not (immediately) affect windows that are 

already displayed, therefore it is necessary to restart the software to update all translated texts. 
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 Calibration -  PWM output   

In the case of milling machines with a 

high-frequency spindle, the spindle 

speed is set using the PWM output or the 

laser power during laser engraving. The 

mapping of the S value in the NC 

program can be adjusted via the 

calibration function, it is set which 

minimum and maximum S value 

corresponds to which voltage value.  

 

To do this, first enter the permissible range for the S value (speed or power level) at the bottom left. 

The middle column shows the assigned values for the minimum and maximum duty cycle of the 

PWM output in percent. The value for the maximum voltage at the bottom right is just for control. 

 

 Testing  

In the upper part of the window, the setting can be tested. When the M3 output is turned on, the 

spindle should rotate at the indicated speed, or the displayed voltage at the analog output should be 

measured. If this deviates, it can be adjusted by adjusting the values for min and max PWM. The 

arrow button to the right of the PWM values adopts the currently set value from the upper area in 

the input field to the left. 

 

 Laser Appl icat ions  

When laser engraving, the output cannot be tested directly because a hole would burn into the 

material when the laser is stationary. Here, the PWM setting must be determined with a special test 

program. This is described in the laser unit manual. 
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 GUI-Sett ings  

These settings affect the graphical user interface (GUI), i.e. the display of the text in the program 

window and the tool path in the graphics window is influenced. This opens a dialog box with two 

pages: GCode-Lexer and Graphics. 

 

 Change G-code representat ion  

The G-Code Lexer page allows you to change the color and font attributes for all the text elements 

of the syntax highlighting.  
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 Change power sett ings   

On the “Graphics” page the performance 

of the graphic display can be changed. 

For very large programs with several 

million line segments (depending on the 

performance of the PC and the graphics 

card from about 30MB file length) can 

lead to performance degradation. This is 

noticeable by the fact that loading takes a 

long time, and moving or rotating the 3D 

display is jerky and delayed.  

 

 

The response time of the other screen elements such as the coordinate display can be delayed. By 

reducing the pixels and the data volume, this can be optimized. When the optimization is active, 

very short lines of the tool path are summarized in the graphic display. 

 

 Accuracy  vs .  resolut ion  

This has no effect on the accuracy of the actual tool path of the machine, but causes only a barely 

noticeable, coarser representation on the screen. The limit for summarizing lines can be either via 

the upper slider or automatically. The lower slider determines the maximum screen build time. If 

the update time for the graphic is longer, it will be switched off completely while the machine is 

running to avoid long reaction times. 
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10  The user-menu   

 

 

 

 

 

 

 

 

 Login . . .   

A small dialog opens in which the desired user 

can be selected. In the Password field, the 

corresponding password is entered and 

confirmed with "Enter".  

 

 

By default, the default user has not assigned a password, so just confirm with "Enter" to close the 

dialog and log in. 

To be able to change machine parameters, you have to log in as "Customer Admin", which has the 

default password of "1234". 

 

 Automatic  login  

If the user has not assigned a password, the next time the program is started, it is automatically 

logged back in without opening this dialog 

 

The currently logged in user is displayed in the status bar at the bottom of the main window, for 

example: "User: Default User" or "User Logged Out".  

 

 No access?  

So if you do not have access to certain menu items, make sure you are currently logged in with 

which user. Users can be assigned passwords to protect the machine from unauthorized 

manipulation (see Chapter user administration). 
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 Lock the operation  

If you leave the machine without switching it off, you can also log out by clicking on "Menu-> 

User-> Logout". 

The user is then logged off and the machine can no longer be operated. 

 

 Logout. . . .  

If you leave the machine without switching it off, you can also log out by clicking on "Menu-> 

User-> Logout". The user is then logged off and the machine can no longer be operated.  
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11  The Support-Menu  

  

 User  Registrat ion  data 

With this menu item you can open a dialog that allows you to 

register the software for a specific user name. Entering a license 

code is not required for the basic version (Economy) of the 

software.  

 

 

 

 Why a  registrat ion?  

Registration may be useful if you want to use the "Send support request“ feature. Entering your 

name and an email address is required in this case to assign the request and to contact you if 

necessary. Of course, this is only at your request. We do not share your information with third 

parties or use them for unsolicited advertising 

 

 Updates  

Attention! Unlike Internet browsers and anti-virus software, where it is always 

advisable to work with the latest version for security reasons, we strongly recommend 

that you do an update only when absolutely necessary, for example because an urgent 

problem has been resolved or you cannot do without a new feature. Be sure to make a backup of 

your settings before updating. After the update, perform a functional check before working on 

expensive workpieces to avoid any surprises due to changed behavior. 
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Assuming that the computer has an active internet connection, you will be informed about the 

availability of a new version of the program in the "Messages" window at the start of the program. 

 

 
 

Before you start an update, it is always recommended to backup your settings. This is described in 

the chapter "create backup". 

 

The update process is started via the menu item 

"Search updates" 

A hint box opens, which version was found and if you 

want to download it now: 

To save the update, choose a location on your 

computer that you can easily find. Ideal is, for 

example, the desktop, or the download directory. 
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If you confirm the entry with Save, the Progress dialog opens and displays the progress of the 

download. 

 

 

 

 

 

 

 

 

If the download was successful, you will be notified. If the 

download was unsuccessful, just start over again. 

 

 

 

 

 

After the download, a note dialog opens with the exact path where the installation file was saved.  

 

 

 

 

 

 

 

 

Now stop the program and install the update by starting (in this example) the 

"C:\Users\Nicolas\Downloads\Test\KinetiC-NC_180316_V166_setup.exe". Follow the instructions 

to the Install the Software and follow the "Install Update" section. Do not forget the functional test! 
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 Send request  

Registration information 

If you open the dialog for the first time and have 

not previously entered any license data, the license 

dialog opens first. This is necessary to be able to 

identify you as a customer in the support 

department. Please enter only correct data and 

remember that support can only contact you when 

all the data entered is complete. 

 

 

 

Problem Description 

If you have problems with the software, you can 

use this feature to send an automatic e-mail to the 

support team. This contains all important 

information about the current state of the software 

and the last executed operations (log file). Apart 

from the machine parameters and the address 

entered in the license dialog, no personal data will 

be transmitted. The log file and parameters help 

the support locate the cause of the problems. 

Please describe your problem in as much detail as 

possible. Not: "machine does not work". 
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 No Internet?  

Usually, an email will be sent to support now. If the control PC does not have an Internet 

connection, you will be notified. 

 

You now have the opportunity to save the information in a file, transfer it with a USB stick to 

another PC with Internet connection, and send it to the support via e-mail. The e-mail address of the 

support can be found on the dealer's website or via the help menu (info about ...). 
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 Check i f  everything  has  been sent  

After successful transfer of the data or storage on 

a data carrier, you will be informed about this in 

the message window. 

 

 

 

 

 

 

 

 

 Logfi le  Options  

This feature allows you to determine what actions are 

logged in the log file and how detailed this information is. 

The more actions or message categories are selected, and 

the smaller the priority is set, the more data is written to 

the log file. In normal operation, the log file is not needed, 

and only a few categories and a high priority should be 

selected in order not to generate an unnecessarily high 

volume of data, which could possibly have a negative 

impact on system performance. 

 

 

 

 

 Support  

But the log file can become important when it comes to finding the root cause of problems. 

Therefore, you may be asked by support to enable certain log options if you report issues. 

 

 Important:  Reset  the  log  options  

If, after submitting the log files to the support and fixing the problem, you reset the log files. 



 KinetiC-NC 

User Manual 

 

 

  

CNC-STEP GmbH & Co. KG ▪ Siemensstrasse 13-15 ▪ 47608 Geldern ▪ Germany Page 82 

Support: +49 (0)2831/91021-50 10.11.2018 

 

12  The help-menu  

 

 User  manual  

With this menu item you can open the PDF version of this manual directly via the software. To do 

this, the default PDF reader is opened. If you do not have a PDF reader installed, a warning appears 

that you must first install a PDF reader. For example, the Adobe Acrobat Reader from 

www.adobe.com or any other PDF reader. 

This manual is also great for printing, if you prefer a printed manual. 

 

 

 Reference  manual  

With this menu item you can open the PDF version of this manual directly via the software. To do 

this, the default PDF reader is opened. If you do not have a PDF reader installed, a warning 

message will appear asking you to install a PDF reader first. For example, the Adobe Acrobat 

Reader from www.adobe.com or any other PDF reader. 

This manual is also great for printing, if you prefer a printed manual. 

 

 

 Environment  

Out of respect for our environment, we do not provide a printed manual about our software. As 

software changes and expands very quickly, new manuals would have to be constantly printed 

because they are never as up-to-date as electronic help. In addition, electronic help is interactive, 

and you can search for terms in it. 

 

 

 

 

 

 

http://ww.adobe.com/
http://www.adobe.com/
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 Help 

This menu item opens the Windows interactive help for this program. 

 

 Search  

With this help you have a powerful tool at your disposal. You can search for individual terms, 

which are then marked in the found text. 
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 Information about. . .  

Here you will see a message with information about the current software version (version number 

and creation date), the registered user data and the e-mail and website addresses of the 

manufacturer. 
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13  Typical  work processes  

There are many different machines, different processing methods, materials and applications, and of 

course different habits and preferences of the users. Of course, not all conceivable procedures can 

be explained in this manual. Only a few examples will be shown so that you can understand the 

basic procedure and adapt it to your own needs. 

 

 

 Process ing plate/sheet  material  

The simplest case is when you use plate/sheet material to make parts that are completely milled out. 

This means that first holes and, if present, inner pockets are milled out. With the last processing 

step, the outline of the part is milled out and the part thus completely separated from the plate. From 

the raw material remains a thin frame and possibly leftover material. There are many applications 

that work on this principle. 

 

• Production of front panels for housings or sheet metal parts in general (also plasma cutting) 

• Parts for modelling (plywood, fiberglass, CFK) 

• Engraving signs 

 

 

 Advantages  

The advantage of this type of processing is that it does not depend on the exact alignment of the 

material. As long as the milling path is completely within the raw material, the parts will always be 

accurate. All you have to do is adjust the Z height exactly. If there are no blind holes or pockets, 

and a sacrificial plate is placed under the material, then this does not even have to be done very 

precisely. 

 

 

 Loading program  

With „File->Open NC file“ you can load a program. For two-dimensional parts this is usually very 

fast, and a preview of the tool path is displayed in the graphics window.  
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The picture above shows an example of a sheet metal part with several holes and recesses. Milling 

paths along the contour are normally displayed in green (possibly with different tools in other 

colors), rapid traverse movements with dashed red lines. The position of the zero point is 

represented by the three arrows in red, green and blue. 

 

The text window below shows the source code of the program. Normally, the first few lines contain 

comments with the name of the part and possibly further information about date of creation, tools 

used and more. 
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 The message window  

It may be that one or more error messages appear in the "Messages" window on the right. If 

"number out of range" is reported, this is not a cause for concern, just an indication that the origin 

of the drawing does not yet match the position of the workpiece in the machine. As a result, it may 

happen that part of the tool path lies outside the travel ranges of the positioning drives. In the 

example shown below, the tool path projects beyond the right boundary of the machine's working 

space, which is shown as a box with gray edges. The area of the tool path that violates the 

boundaries is displayed in orange.  

 

 Error messages  

The associated error message could be for example: 

 

X = 200,263 is above the upper limit of 200,0 

X = 200,263 + offset (G54) 200,00 = 400,263> axis limit 400 

Number out of range row 30069 column 3 

 

The first line shows that the coordinate in the NC program (G code in the program window) is 

programmed to a target position of 200,263. With the current settings, however, the X axis may 

only drive up to a value of 200.0. The second line gives more detailed information why this is the 

case: The currently selected zero point is G54. The X offset of the zero point is 200.0. The absolute 

upper limit for the X coordinate (set in the machine parameters) is 400.0. The X-coordinate from 

the program (200,263) plus the offset results in a sum that is above the limit. The third line indicates 

the text of the error within the program. The position will also be highlighted in red in the 

"Program" window on the left. 
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 Presentat ion in  the  graphic  

As you can see from the picture, the 

working surface protrudes to the right 

out of the processing area of the 

machine, and should be moved to the 

left, in the direction of smaller X-

values. 

 

 

 

 

 

 

 

 

 Set  zero  point  

The following description assumes that the zero point in the 

drawing is at the top of the material, as in the example of the 

image, and at the bottom left in the X / Y direction. If the 

coordinate display on the top right screen still has a green 

background color, then no workpiece offset has been 

selected and "G53 (Machine Coordinates)" is displayed 

below the coordinates. 

 

 

 
 

First select an offset there, e.g. "G54 (workpiece offset)". The coordinate display changes to blue 

background color. 
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 Place  the material  

After you have fixed the material on the table of the machine, now move with the Hotkeys (number 

pad) or the jog buttons on the Setup-Page to the point where the workpiece zero point should be. If 

you have just switched on the machine, a warning appears that no homing has yet been performed.  

 

 Homing  

Select "Now homing" and then move to the desired 

position. The tip of the cutter should be just above 

the material surface and in the X / Y direction 

slightly inside the lower left corner of the material.  

 

 

 

Now press the "all zero" button on the left side of the coordinate display. On the main 

page in the graph, the tool (light gray cylinder) is located at the point of origin (three 

colored arrows), and the tool path should have the desired position in the processing 

space, completely within the acceptable limits, as indicated by no part is marked in orange, and all 

lines are inside the gray box. In the message window no error message should appear anymore, only 

"used zero points ...". 

 

 Zero adjustment  

You can now carry out a fine adjustment of the zero point, for example with the paper method 

described in the chapter „Setting up the zero point“.  

Of course, if your work contains blind holes or pockets whose depth should be exactly right, you 

must now subtract the thickness of the paper from the Z coordinate of the offset. If you know this 

thickness (for example, using a calliper gauge), you could carefully and slowly lower the z-axis by 

that amount, and then press the zero Z-coordinate button again. It is better, however, not to risk a 

tool break, and enter the number directly. You can double-click on the Z coordinate display, and in 

the pop-up window that appears, for example, type "0.1". The zero point is then 0.1 mm lower than 

the current position of the cutter tip. This also avoids scratching the material surface. 
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 Start ing the  program  

If the zero point is set correctly, the 

graphic display shows the tool path as 

expected, and no error message appears 

in the message window, you can start the 

program.  

The button for this is located 

on the main page ("Program") 

on the left below the graphics 

window. In the event that an 

error message has been displayed or the 

text display ("Program" window below 

the graphic) is not at the beginning of the 

program, the start button may be disabled 

(gray). In this case, you can first click on   

 

"Rewind", then the text display 

jumps to the beginning of the 

program and the start button 

becomes active again. 

 

 

 

 Adjust  feed  

Before starting a new program for the first time, it is 

recommended to set the feed override (slider "Feed%" top right) 

to a small value (eg 10-20%) to slow down the machine.  

 

 

If you have made a mistake while setting the zero point, if the wrong tool is in the spindle, or if the 

machine makes an unexpected move to the wrong place, you still have time to react to an imminent 

collision. 

 

Pressing the stop button stops the program, or in an emergency, of course, the emergency 

stop button on the machine. 

 

If everything works as expected and without any problems, you can reset the Feed% 

slider to 100%, which is easiest with the Reset button. 
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 Problems? How to  s top?  

If a problem occurs during machining, for example, swirling chips around the tool, or the tool 

breaks off and needs to be changed, you can stop program execution at any time by pressing the 

Stop button. After a short delay until the spindle motor has come to a standstill, the start button is 

released again. After eliminating the problem, you can resume editing at the same location. 

 

 Continue  aga in  

However, after a tool break, the controller may have allowed a small part of the program to 

continue without the (broken) tool being engaged. In order not to omit any piece of the tool path, 

you would actually have to rewind this section again. Depending on how far you have travelled 

since the break, you can scroll up a few lines in the text window and double-click on the desired 

line.  

 

The left start button is disabled (gray) and the second button  to the right is activated. 

When starting with this button, a window now appears with a warning as shown in the 

picture below. 
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 Start  program at  any  point  

Retaining a program at any point carries a certain amount of risk depending on the type of 

workpiece, the tool and the machining strategy. In extreme cases, such as a T-slot cutter, which is 

located in the middle of the material, no resuming at this point is possible at all, without damaging 

workpiece or tool. Since the controller cannot automatically detect such hazards, the responsibility 

lies with the operator in such cases. If in doubt, calculate that the tool travels diagonally to the next 

machining point with all axes at the same time, in other words under certain circumstances it may 

be that there is still raw material on the way there. If you cannot be sure that a collision will not 

occur, then rewind until you reach a non-hazardous location, such as a safe Z-height outside of the 

material. 

 

For short programs that only run for a few minutes, and if the part is not too valuable, it may not be 

worth continuing, and it is better to run the program completely from scratch, instead of risking 

another tool break. 

 

 Addit ional  t ip  

The title bar at the top of the main window displays the name of the currently loaded program. 

 

 
 

The status bar at the bottom left shows the complete pathname of the loaded program. To the right, 

the line number is displayed, how far the processing has progressed 

 

 
 

If you cancel a program, and If you want to continue the next day, make a note of this line number 

to find the right place to continue later. 

 

 Execution t ime  

At the far right, the preview displays the estimated execution time after loading the program, and 

the elapsed time during execution.  
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 Statis t ical  funct ions  

 Running-t ime meter  

On the diagnostics page, the hours and parts 

counter are displayed at the bottom of Statistics. 

The operating hours counter and the user clock 

always run while a program is running.  

 

 

 

 Parts  counter  

The part counter is incremented by one with each complete execution of a program. The user clock 

and the parts counter can be set to zero if necessary. 

 

 

 Tool  path  sett ings  

Right next to the tool display (in the middle column of the main window) there is a 

button for the tool path settings.  

 

 

This can be useful in order to influence the path of 

tolerance (chord error) or feed and spindle speed 

afterwards, without having to change machine 

parameters, or having to edit the program in the text 

editor. If the program contains several machining steps 

with different tools, these are displayed below under 

"Tool selection". It is possible to exclude individual work 

steps, or to select only one of them. 
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 Other material  

If the workpieces do not have to be completely milled out of plate material, but you have to (re) 

process blocks, cylinders, castings or pre-machined workpieces, they are usually clamped in a vise 

or held on the machine table with clamps. If not, the entire surface is machined, the workpieces 

must be aligned exactly. You therefore need not only measure the Z-height, but also the position of 

the workpiece in the X and Y direction 

 

 Posit ion  of  the workpiece  

In the simplest case, this can be done again by "scratching" the surface with the tool itself. To do 

this, drive sideways to one edge of the workpiece until the tool just touches the edge. Now the axis 

of the milling cutter is half a diameter from the surface. For example, if you drove to the edge in the 

X-direction, and the tool diameter is 6mm, then the cutter center is 3mm from the edge. 

 

Double-click on the X-coordinate display and enter "-3". Of course, the same procedure is 

necessary once again for the Y and Z coordinates. 

 

 Probe  

The measuring process can be automated if you have a 3D probe. In contrast to the height sensor, 

the 3D button also reacts when actuated from the side and is inserted into  

the tool spindle. The macro "corner finder" can be used for the lateral probing of the workpiece 

edges.  

 

 3D-probe  

The 3D probe is also suitable for measuring bores as a reference point. 

The tip of the 3D button must be placed within the hole. The "Center 

Finder" macro probes the wall of the hole in several places and 

determines the position of the hole center. After execution of the macro, 

the measuring tip is exactly in the center. The X and Y coordinates can 

then be set to either zero or (by double-clicking) on the known 

coordinates of the reference point. 
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 Camera-centering  

An alternative method for determining edge or bore positions is to use a miniature camera as a 

centering microscope. For this purpose, special cameras are commercially available, usually with 

USB port and a cylindrical shank, which can also be used in the recording of the tool spindle. 

 

 

 Working  with  height  probe  

 What is  a  height  probe?  

A height probe is a small device that gives an electrical signal to the 

controller when it is driven from above with a tool. It can either be used - 

permanently installed - to measure the length of the tool after a tool 

change. In this case we speak of a tool length sensor. Or it is used mobile 

to determine the height of the workpiece surface, and to set the zero 

point automatically. This is a significant reduction in labour compared to 

the direct "scratching" of the workpiece surface or the "paper method" 

mentioned above. 

 

 

 The procedure  

The procedure is as follows: The button is connected to the controller and placed on the material 

surface. The tool is moved vertically over the button of the probe. Then a macro is called, which 

means a small program is started, that does the measurement automatically. The tool moves slowly 

on the probe until the switching point is reached. The height of the probe itself, from the top button 

to the bottom of the case, is subtracted from the position reached, and the result is stored as the Z 

coordinate of the workpiece offset. Thus, after that, the coordinate zero point is located exactly on 

the workpiece surface. 

 

 

 Connection  

The height probe is normally connected to an extra socket 

on the machine or controller. For more detailed 

information, please refer to the documentation for your 

control hardware. To use the macro for hight 

measurement, you must first import it.  
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To do this, go to „File->Import settings" and 

select the file "HighZ_LengthProbe.ini" in 

the "Addons" subdirectory under "Default 

parameters". This will both install the 

required macros and assign the input for the 

probe with the standard pin-assignment. 

 

 

 

 

 

 

 

 Testing  before  use  

It is very important that you check the correct function of the probe 

before first use. To do this, please switch to the Diagnostic page. 

 

 

 

 

For the inputs (top right), a "tool length 

sensor" entry should be visible with a box 

to the left. In the normal state, no check 

mark may be displayed. Now press the 

button with your hand. Now a tick must be 

visible. If nothing changes, the probe is 

either not connected correctly or the signal 

is assigned to the wrong pin.  

 

 

If the behavior is exactly the opposite (tick visible if button is not pressed), then you must invert the 

signal. You can do this under „Configuration->Machine->Inputs/Outputs" by clicking on the 

input "Tool length sensor" and then "Change". To invert the signal, change the state of the option 

"low-active", top right. 
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 Height  of  the measuring  probe  

Now the height of the probe must be 

determined and entered into the 

machine parameters. First determine 

the approximate height of the probe 

with a caliper gauge and enter it in the 

configuration dialog on the page 

"Macros" at Variable number # 953 

"Tool length sensor height for Z0 

determination". 

 

 

 

Now place the probe on the material and the tool via the probe. If you now call up the macro 

(double-click on "Height measurement with mobile probe" on the Special Page), the measuring 

process will be carried out. 

 

If you now remove the probe and lower 

it with the tool until it just touches the 

material, a Zero coordinate should be 

displayed near Zero. The small 

difference - ideal would be exactly 

zero - comes from the fact that the real 

switching point of the probe is located 

at a slightly depressed ram, and this 

cannot be measured accurately with the 

caliper.  

 

Therefore, the variable # 953 needs to be corrected slightly. 

If a positive Z value is displayed, the offset has been set too low and you must reduce the variable 

by the displayed Z value. Conversely, if the Z is negative, the variable must be increased by the 

amount. 
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 Tool  management  

Why? 

As soon as you need more than just one tool per workpiece, you have to think about how to make it 

happen that, despite different lengths, diameters and shapes, the machining is done in the right place 

and the right plunge depth. That means, the controller must "know" which tool is currently in the 

machine and how long and thick it is, etc. There are different tool change methods that require 

different approaches. 

 

 Without  tool  change  

This is the simplest case. Only one tool is used per CNC program. This sounds like a drastic 

limitation, but it's not that bad when it comes to CNC machining, at least if you only work on thin 

plate material. You can, for example, to produce holes with different diameters, select a tool to 

match the smallest hole, and mill for the larger one circle. In this way, one often gets amazingly far 

with a single tool. 

 

13.5 .1 .1  Distribution of  the program  

If you need several tools in succession, the processing is divided into several programs. Each 

processing step is carried out separately. In between, the tool is changed manually and then the zero 

point is re-measured. In this case you only need a single tool (T1) in the tool list. You can enter the 

tool data in the list (menu "Configuration -> Tools"), but this is only relevant for the display on the 

screen. Since the workpiece offset is re-measured after each change, the entered tool length is 

irrelevant, and you do not have to worry about the tool number. The setting in „configuration-

>machine->general" is best set to "Ignore tool change" to avoid unnecessary requests to change 

tools. You have to have the tool anyway before the start suitable for the program have changed. 
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 Manual  tool  change (direct)  

Even if one does not have the "luxury" of an automatic tool changer, one can work off programs 

with several different tools. In this case, the setting in "Configuration -> Machine -> General" is set 

to "Tool change manual". In addition, you should create at least as many tools in the tool list as 

occur in the programs used, eg. T1 to T10. 

 

 Direct ly  used tools  

If the tool spindle does not have an exchange system with extra tool holders (usually SK = steep 

taper, HSK = hollow shaft taper), but the tool with the shank is inserted directly into the collet 

chuck in the motor shaft, this is called direct change. The advantage is that this can be done with 

any reasonably priced tool spindle. Disadvantages are that the tool can be in a slightly different 

position after each change, and that with different shank diameters each time the collet must be 

replaced with. This requires more time, and usually the tool length must be re-measured after each 

change. 

 

 Tool  length sensor  

For this reason, when switching directly, it is strongly advised to purchase a tool length sensor. This 

is the same as the height probe described above, only fixedly mounted at a certain point on the 

machine. There are also combined length and height probe, where the same probe can be used for 

both purposes. Such a button usually has a magnetic foot, which is firmly mounted on the machine. 

There, the probe is used for tool length measurement. For mobile application to measure the 

workpiece surface height, the probe can be removed from the foot and placed on the workpiece. In 

contrast, if two separate buttons are used, they can nevertheless be connected to the same input of 

the hardware (series connection) because the buttons are never used at the same time. 

 

 Without  tool  length sensor  

If you do not have a length sensor, it is best to use the "no tool change" method and separate the 

programs so that each machining step is performed separately with just one tool. Alternatively, the 

program can also be left "in one piece", but only one of several tools can be activated each time it is 

run. You can do this by switching off the "Select all" toolbox in the Tool path dialog and activating 

only a single tool. 
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 With tool  length sensor  

To perform the length measurement automatically after every tool change, you must first install the 

survey macros as described in Chapter 27  "working with hight probe" After this, the position of the 

button must still be entered in the machine parameters, so that the controller knows where the 

length sensor is, what height it has, and at what speed it can be approached. 

 

The parameters # 951, # 952 and # 960 to # 964 are used for this purpose. First enter the X and Y 

position where the button is mounted on the machine table. The safety position is approached after 

the measurement. This should be somewhere in the distance next to the button. This prevents the 

probe from being damaged if, after a measurement, a program is started which moves as the first 

movement with the Z axis all the way down. 

 

The "offset Z-axis" (# 962) can later be adjusted so that the measured tool length corresponds to a 

dimension (in principle arbitrary but verifiable), for example the length of the part of the tool that 

protrudes from the collet. The exact value is actually insignificant, since only the difference in the 

length of the old and the new tool is relevant when changing tools. If a different offset is entered, all 

tools are measured longer or shorter, but the relevant length differences when changing tools remain 

the same. 

Enter the appropriate values for your machine and save it. Remember to check the function of the 

signal input before using it for the first time by pressing the probe manually and observing the 

response of the input on the diagnostics page. 
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 G40/G43 Mode  

When working with several tools, it is important that 

the tool length compensation is switched on. Only then 

is the length of the current tool taken into account and 

added to the programmed Z value. In particular, the 

length compensation must also be active while you 

measure and set the workpiece offset (either with the 

height key or with the "scratch method"). Therefore, 

before setting up the workpiece offset, make sure that 

"G43" appears next to the offset by pressing the button. 

 

 Manual  change with tool  ho lders  

The tool change can be somewhat more rational if the machine has a change system with tool 

holders and pneumatic or hydraulic clamping. Some machines also have a threaded pull stud that 

needs to be tightened with a wrench by hand. Each tool is first inserted in a tool holder (usually SK 

= steep taper, HSK = hollow taper or other systems). During the actual tool change, the pictures are 

then loaded into the tool spindle. The tool remains in "its" receptacle as long as it is not worn or 

damaged. 

 

 Advantage  

This has the advantage that the length measurement must be performed only after the insertion of a 

new tool in the recording. This can be done either automatically as described above with a length 

sensor or manually with an extra length measuring device (in the simplest case with a calliper) 

outside the machine. The determined length is entered in the tool list and is then only looked up 

there during the actual tool change. 

 

 How is  measured?  

The absolute length of the tools is actually irrelevant, only the differences between the tools are 

considered. For example, with all tools, it is possible to measure the distance of the tip to a specific 

reference plane, for example the stop plane of the HSK cone. The important thing is that each time 

exactly the same reference plane is taken. The front of the collet nut is therefore unsuitable because 

its exact position depends on the tightening torque. 
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 Simple entry in  the  l i s t  

The manual change with tool holder does not require special macros or other adjustments if you 

enter the tool lengths manually in the tool list (Configuration -> Tools -> Change -> Length 1). If 

you have a length scanner, you can install and customize the G79 macro as described above. 

However, it is not invoked every time a tool is changed, but only when needed, either via the MDI 

input or by selecting the option "with length measurement" in the tool change dialog (main window, 

"tool change" button, left). As described above, you must also make sure that the tool length 

compensation (G43) is active. 

 

 

 Automatic  tool  change (direct )  

If the tool spindle has a pneumatically or hydraulically operated mechanism with which the collet 

can be opened and closed without manual intervention, an automatic change of the tool is possible. 

Of course, this also requires a magazine in which several tools can be stored.  

 

 

 Magazine  types  

There are fixed (linear) magazines in which each tool is picked up at a different position by utilizing 

the X, Y and Z positioning of the spindle, or moving magazines (revolvers) where the pickup is 

always at the same X / Y / Z position, but there is an additional drive to select the tool. 

 

Since the exact position of the tool is not always the same when changing directly into the collet, a 

length measurement must be carried out after every change. A length measuring probe is therefore 

necessary in every case. The setting in "Configuration -> Machine -> General" must be set to "Tool 

change automatic".  

 

 

 The M6 and G79 macro  

For the actual tool change, an M6 macro must be installed and adapted, for the length measurement 

the G79 macro. Special programming is required to program the automatic change. The Reference 

Guide lists examples of macros for each simple linear and revolver magazine. Even more 

complicated systems, for example linear magazines with several rows or revolvers with additional 

robot arm are conceivable. However, it is recommended that you seek professional help in 

programming and adjusting such changer systems. 
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 Automatic  change  with  tool  hol ders  

If the tool is not inserted directly into the collet but into its own tool holder, the length measurement 

after each change can be dispensed with, as with manual replacement with tool holder. This results 

in the advantage of shorter cycle times in mass production but is also the most expensive system. 

As with automatic direct change, several magazine types are possible again. A length measuring 

probe is not absolutely necessary. If the tool lengths are measured by hand and entered in the tool 

list, no probe or G79 macro is required. 

 

 Rotary  axis  and cyl indrical  engraving  

With the normal, three-axis machining (X, Y, Z), the workpiece can only be machined from one 

side - vertically from the top. If you also want to machine the reverse side, you will need to turn the 

workpiece over after the first pass and start a second pass. With a rotation axis (available as an 

accessory), you can rotate a workpiece at any angle and work from all sides around the 

circumference. 

 

In the following description, it is assumed that the rotation axis is already connected to the 

controller, and the parameters (resolution, speed, etc.) in the machine parameters are set correctly. 

The necessary steps for the installation can be found in the separate documentation for the rotary 

axis.  
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 Cylindrical  engraving  

Drum engraving is the simplest machining method with a rotary axis. The normally flat working 

plane (XY) is "wound up" on the circumference of a cylindrical surface. If the axis of rotation is 

aligned parallel to the X axis, the axis of rotation (A) is moved, for example, instead of the Y axis. 

To avoid distortion of the image, the workpiece diameter must be known. This is necessary for the 

controller to calculate how many degrees of turn it takes to travel a certain distance on the surface. 

 

 Simply  without  CAM  

For drum engraving, no special CAM program with rotary axis support is required. You can even 

use an existing NC program that was originally designed only for flat plate flat machining, later for 

drum engraving.  

 

 Where  is  the rotary  axis  mount ed?  

All you have to do in the machine configuration (configuration->machine->special->drum 

engraving) (see picture above) is see if the axis of rotation is parallel to the X or Y axis.) Normally 

the axis of rotation will be parallel along the long side of the machine In this case, select "Y-axis is 

projected on A-axis" and activate the option "Position is determined from current zero point" as 

shown below: workpiece diameter and Y and Z position of the axis of rotation are still irrelevant at 

the moment and will be specified later. 
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 Insert  workpiece  

After inserting the workpiece into the rotation axis, the workpiece zero point must be placed on the 

material surface vertically above the center. For an A-axis of rotation parallel to the X-axis, move to 

the workpiece so that the tip of the cutter just touches the top of the cylinder (pipe, rod, etc.) and set 

the Y and Z coordinates to zero.  

 

 Probing  the  workpiece  

In order to find exactly the center point in 

the Y-direction, you can either touch the 

workpiece on both sides laterally, or 

instead of the actual workpiece first clamp 

a cylindrical pin in the jaw chuck whose 

diameter matches that of the tool, pin and 

cutter congruent drive over each other, and 

first set the Y axis to zero. Then clamp the 

real workpiece again and set the Z 

coordinate to zero on the top. 

 

 

 

 Load NC program  

Open now the NC Program. The tool path is initially 

displayed "flat", i.e. parallel to the XY plane. 

Now go to the tool path dialog via the button to the right of 

the tool display (see picture above right). Switch to the 

"Drum Engraving" tab and activate the check mark "Engrave drum active". If you now enter the 

correct workpiece diameter (or optionally radius or circumference) and exit the dialog with "OK", 

the graphic is rebuilt and the tool path appears curved, wrapped around an imaginary cylinder. The 

picture on the left shows an engraving once with drum engraving turned on and once "flat", with 

drum engraving turned off. 

 

 Turn off  drum engraving  

If you want to process a "normal" workpiece after finishing work, you should switch off the drum 

engraving option again. If the train preview looks strange, or you get inexplicable error messages, 

this may be a sign that you have forgotten it. 
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 Tangentia l  kni fe  cutt ing  

 What is  i t?  

This machining method does not work with a tool that rotates at a constant speed, but rather a knife 

is always rotated at the correct angle tangential to the tool path with an extra positioning drive,  this 

explains the name. The knife may be either rotatable but vertically fixed or oscillating. With the 

fixed knife usually slides are cut, with an oscillating knife even thicker materials such as foams can 

be cut. 

 

 Import  of  option  

The KinetiC-NC software supports the automatic turning of the knife in the right direction, without 

having to explicitly specify the angle of rotation in the NC program. To do this, the machine type 

must be set to "Knife Cutting Machine", a rotary axis "C" must be defined, and a few other 

parameters must be adjusted. The easiest way to do this is to import the file "Tangential-Knife.ini", 

which is located in the subfolder "Addons" of the default parameters (menu File - Import Settings - 

Default Parameters). 

There, all necessary parameters for the most common tangential knife type with stepper motor and 

1: 1 gearbox are already predefined.  

 

 Backup  

If the machine is also used alternately for milling, do not forget to make a backup of parameter 

before importing the tangential file. 

 

 Checking  the  knife  

Before using for the first time, check the resolution of the C 

axis and the correct orientation of the knife. There are knife 

drives with different resolution. The tangential gauge EOT-2 

has e.g. 200 full steps per revolution, which corresponds to a 

resolution of 5.55555 steps / ° in 1/10 micro step. The 

tangential EOT-3 has twice the resolution. 

 

 

First carry out a homing run on the C axis. If the C axis coordinate display is not zero, use the C + / 

C rotary arrow buttons on the Setup page to move the axis to the zero position. Do not use the zero 

button, this would just set the coordinate to zero without rotating the knife. Now check that the 

blade of the knife points exactly in the X + direction. For a high-z machine this means that the knife 

must be aligned parallel to the long axis with the cutting edge to the right. 
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 Reference  switch  and homing  

If the cutting edge is not aligned correctly, use the C + / C button to turn the knife to the correct 

angle. Note the displayed C coordinate and subtract it from the value "Reference switch position" in 

the axis parameters (Configuration - Machine - Axis parameter, select axis: C For example, if 

"Reference switch position" was -55 before, and the coordinate display for exact angular orientation 

is +3.5, then you must enter -55 - 3.5 = -58.5. Then carry out a new reference run and repeat the 

check of the angle. 

 

 

 No CAM program necessary  

For cutting with tangential knife, it is not absolutely a CAM program necessary. You can import the 

lines to be cut directly as an HPGL or DXF file and only need to specify the plunge depth and 

security height for trips over the material. Alternatively, you can also use a G-code program. This 

should only be 2-dimensional, this means it consists of a sequence of rapid traverse positioning 

(G0) above the material, an insertion movement (G1 with Z movement vertically downwards), one 

or more XY movements within the material (G1, G2 or G3 without Z) and a lifting movement (G1 

with Z movement vertically upwards) and any number of repetitions. 

 

 

 Sharp corners  or not  

It is important that the drawing has tangent-continuous transitions at all points where liquid is to be 

passed through. Wherever sharp-edged lines about each other, the control automatically generates 

an additional  and insertion movement. This is intended if, for example, a sharp-edged rectangle is 

to be cut and prevents the unsightly tearing of the material or even a breakage of the blade, which 

could happen if the blade had to be turned too large an angle within the material. If the blade is not 

to be taken out of the material, the corners of the rectangle must be rounded with quarter-circle arcs. 

 

 

 Clean drawings  

It is also important that the drawing is made carefully and that the starting points of the following 

lines are exactly at the end points of the preceding lines. Gaps or overlaps not only lead to jerky 

movements, but because of the step-like direction changes also to unnecessary excavation, turning 

and insertion movements. The limit values for the angles between successive lines, from which a 

stop or an lifting  / insertion movement is inserted, can be set in the machine parameters on the 

special page.  
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 Control  of  the  drawing  

However, if you experience problems with 

frequent stops, jerky movements, and 

unnecessary insertion, first check your 

drawing to see if the start and end points of 

the lines are clean and the transitions are 

constant tangent. 

 

 

 

 

 

 

 

 Presentat ion in  the  graphic  

The points at which the knife is lifted out can be recognized as vertical lines in the path preview 

(see picture on the right at the corners of the rectangle and on the left at the circle). If lifting 

motions are present at locations on the web where they should not actually be, this is an indication 

that there are either tiny gaps or intersections, possibly not visible, depending on the magnification, 

or the transitions are not continuous, too big "kink" (angle). Excavation movements at (intentional) 

90 ° corners as in the picture on the right are quite normal. 
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14  Troubleshooting  

When operating a CNC machine many different problems can occur, which of course not all are 

mentioned here. The following sections list only those issues that can occur frequently during initial 

startup and for which there are standard solutions. 

In case of unforeseen problems you can contact the Support. If possible, try to solve the problem first 

by using this guide. 

 

 Functions  locked  

Not all functions of the software are allowed at any time. It may happen that certain buttons and menu 

items are locked. In the picture below, for example, the machine movement, spindle and coolant 

function and tool change and homing are disabled ("greyed out"). 

 

 

 

All machine movements are of course blocked as long as the emergency stop is active. First check 

the symbols in the "Status" field. 

 

 

 

 

 

 

There, one or more of the following symbols will appear: 
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With "OK" the machine is ready. "Emergency Stop" means that either one of the emergency stop 

buttons on the machine or on the control is pressed, or there is a problem with the electronics 

(power failure, interrupted cables, etc.). The exclamation point triangular warning sign indicates a 

problem with an external device that is signalled by an alarm signal (see "Frequency converter 

alarm" in the status field above). In this case, please refer to the instructions of the external 

extension (for example, the frequency converter) for the cause and instructions for correcting the 

problem. 

The warning sign with the door appears if the machine is equipped with a safety door and it is 

open. This is described in more detail below. 

 

When the DEMO icon appears, there is (still) no connection to the hardware. The 

software runs in demonstration mode and simulates the machine movement only in the 

3D graphics. The right-hand plugged icon indicates that a connection existed but was 

subsequently disconnected (see below, "Connection interrupted") 

 

Regardless of the state of the machine, there is another reason why functions may be limited: Some 

functions require special rights. In order to be able to change the machine parameters, for example, 

you have to be logged in as an administrator. Therefore, in the picture below "Configuration - 

Machine" is greyed out. (See also "User-Login") 

 

 

 Connection interrupted  

The above icon indicates that the connection to the CncPod has been disconnected. This may not 

only be due to the cable connection itself but also to the operating system (anti-virus, firewall, 

energy-saving mode, see also chapter "Installing CncPod"). 

If this always happens at a certain time, e.g. Turning on a powerful device (compressor, exhaust) 

indicates electromagnetic interference. A momentary voltage fluctuation can lead to a breakdown of 

communication between PC and CncPod. 

On the other hand, if it is idle, but always after a certain amount of time after starting the software, 

the power-saving mode of the PC can be the problem. For Windows 8 and 10, and especially for 

portable devices, the operating system may shut down the network connection after a few minutes 

without Internet usage. This can be prevented if the CncPod is connected via a network switch. 

 

To re-establish the connection, first check all cable connections and the power supply, and then go 

to the menu "Configuration->Hardware". 
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 Error  messages  

In manual mode, the machine functions flawlessly, ie in  Setup-mode  all axes can be moved, the 

spindle can be switched on and off etc. When starting a program, however, you will receive an error 

message in the Message window. 

The most common causes are: 

• “Out-of-range number": The tool path is too large for the machining area of the machine, 

or the Workpiece zero point is in the wrong place, leaving parts of the tool path out of the 

range. 

• "% Character missing at the beginning of the program" or "unexpected character" or 

"unknown command": The program was created with a post processor for other control 

software (e.g., Mach3 or the like). Although the G-code is standardized in principle and is 

largely the same for all control types, not all controllers understand all commands. If you 

use your own CAM software that was not supplied with the machine, check our website to 

see if there is already a ready-made Post-processor for KinetiC-NC and your CAM software. 

Tips for creating or customizing your own post-processor can be found in the Reference 

manual. 

 

 The machine  does  not  re act  as  expected  

If the machine is working properly in manual mode, means in Setup-mode all axes can be moved, 

the spindle switched on and off, etc., but the program does not run the expected tool path, moves 

too fast or too slow, or stops at certain points, may be the faulty setting of the CAM software or the 

wrong Post-processor has been selected (see above). Since the possibilities here are very diverse 

and difficult to predict, it is best to contact the support. 

If you do not send an automatic support request it is best to send the program that caused the 

problem and your parameter settings, and describe the problem as accurately as possible, otherwise 

it will be difficult to quickly analyse the cause. 

 

 Security  door  

If your machine is equipped with a housing, the safety door 

function prevents the machine from being moved as long as the 

door is open and allows the user to reach into the hazardous 

area of the machine. Starting programs and switching on the 

spindle motor or other outputs is only possible with the door closed. As long as the door is open, the 

triangular warning symbol with the door open will be displayed in the status field. 
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 Maintenance mode  

The safety door and the alarm function are usually designed to protect the user from injury and the 

machine from damage. In certain cases, however, the safety functions may block each other. 

Suppose there is a technical defect that triggers an alarm condition. However, the defect can only be 

remedied if the machine were moved a short distance to get to the location with the defect. The 

alarm blocks all machine movements. 

In this case, there is nothing left but to break the "vicious circle" by overriding the blockage caused 

by the alarm condition.  

 

This is the maintenance mode, which is activated with the button  on the setup page. 

Since overriding the security feature involves a high level of risk, this feature is only 

available when logged in as an administrator. Before releasing the machine and 

switching outputs, the following warning message is displayed, which must be confirmed firs 

 

 

 

In order to prevent the maintenance mode from permanently bypassing the safety functions, the 

execution of CNC programs in maintenance mode is not permitted. In order to resume normal 

operation of the machine, maintenance mode must be exited first. This happens automatically when 

closing the security door. 
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15  Import f i l ter  

The standard version of the software contains 2 import filters. One is the HPGL import filter for 

importing HPGL or plot files and the other is the DXF import filter for importing the popular and 

popular DXF graphics format. 

 

 

 DXF-Import  f i l ter  

Short description: 

The DXF import filter is used to convert drawing data that exists in dxf format to DIN-G code for 

the KinetiC-NC software. The import filter reads files in DXF ASCII format. 

The following elements from DXF files are read and taken into account: 

 

• Layer (layer names are displayed) 

• Line (lines with 2 vectors in 2D or 3D) 

• Circle (circle with center vector in 2D or 3D and radius) 

• Arc (angle) 

• Polyline (as open or closed line) 

• Vertex (2D or 3D, points for polyline) 

• Point (2D or 3D) 

 

 What is  imported?  

Not supported are B-splines (Bezier lines), also no 3D-solid data. However, all supported elements 

are also supported in 3D, ie with z-values. 

If the elements Point or Polyline (with only one vertex) are included, they are interpreted as drilling 

points. 

Line, Polyline, and Arc are grouped into segments if they have common start / end points. The 

tolerance of catching these points can be set by software and is by default at 0.001mm.  

 

 The mil l ing  direct ion  

The direction of the individual elements is adjusted and possibly changed. The milling direction of 

a single segment therefore depends on the direction in which the first element found was drawn. It 

is also possible to delete individual segments or specify individual Z-depths, laser power or feed 

rates for individual segments. 
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 The import  process:  

The file to be imported is selected and opened under Menu / Import Drawing. If this file contains 

correct, readable DXF data, the following dialog opens: 

 

In the upper field, the layers are displayed with data. Layers in the file that contain no evaluable 

data are not displayed. Layers can be activated / deactivated individually. Only active layers will be 

imported. The size of the data to be imported is always updated and applies only to the active layers 

/ segments. By clicking on the tabs of the left side, the following additional settings appear: 

 

 

 Tab:  Layer defaul ts  

Here it is determined which data should be used to convert the individual layers. 
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Z-depth 

1) For all layers, the Z depth set in the Global Setting field is used for milling / drilling. 

2) Each layer is set with individual values. 

3) (only active if layer contains 3D data) The Z values from the layer data are used. 

 

Feed 

1) For all layers, the value specified in the Global Setting field is used. 

2) Each layer has individual feed values. 

 

Zero offset 

1) The zero point is not changed but remains as specified in the file. 

2) The zero point is placed in the lower left corner of the workpiece. 

3) The zero point is placed in the middle of the workpiece. 

 

Tools 

1) For all layers, the value specified in the Global setting field is used. 

2) Each layer has its own tool. 

 

 Tab:  Global  Sett ings  
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Here are the settings that are used both as default values for changing the individual values of a 

layer and the Global values if no individual values are set. A distinction is made between milling 

data and drilling data (only available if at least one layer contains drilling data in the file). 

 

 Sett ings  for mil l ing  

Z-depth 

Value, how deep into the material to be milled / drilled. 

 

Spindle speed 

Value for the speed of the milling spindle 

 

XY feed 

Value for the G1 feed in mm / min 

 

Tool 

The tool to use from the tool list 

 

Z-feed 

G1 feed to be used for immersion in the material. 

 

 Sett ings  for dri l l ing  

These data can be set separately from the milling data. 

 

G81 / G82 / G83 / no cycle: 

Here you choose whether a drilling cycle should be used. If no cycle is selected, code will be 

generated that behaves as if G81 was selected. 

 

Z-Depth: 

Borehole depth in mm 

 

Retreat R: 

Retraction plane to which the drill is retracted before drilling or re-immersing a new hole. 

 

DWELL: 

Pause time to stay at the bottom (G82) 

 

swarf removal: 

Depth to be delivered (G83) 
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 Tab:  Sett ings  

This field displays the general data for the machine or workpiece / material. 

 

 

 Z-values  of  material  and machine  

 Material  top:  

Highest part of the material to be milled / drilled 

 

Z-level security:  

Height at which it is safe to travel at rapid traverse (G0) without colliding with the clamping device. 
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 General  set t ings:  

Saving parameters  

If this option is selected, all settings are saved and will be recalled on the next import. 

The resetting of all values to factory settings is done with the button "Standard values". 

 

CV mode 

When selected, the constant velocity mode is selected instead of the exact stop mode. 

 

Create line numbers 

When selected, line numbers are output in the G code. 

 

File in inches scale 

When this box is checked, the coordinates in the file are interpreted as inches. 

 

scaling: 

Any value for scaling the file can be specified here. 0.5, for example, cuts the file in half, meaning 

that a 100x100mm template is now only 50x50mm in size, but an indication of 2.35 would scale a 

100x100mm file to 235x235mm. 

 

Program extreme values 

Here the maximum coordinates of the entire program are displayed. Also, the absolute size of the 

workpiece is displayed. When activating / deactivating individual layers, this value is automatically 

recalculated. So only the dimensions of the active layers are displayed. 
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 Layer-Detai ls  (Layer List ):  

 

By right-clicking with the mouse on a layer in the layer 

list, the global settings are assigned, or you can display 

and modify the set values. Thus, individual values for 

feed, Z depth, tool or drilling can be set for each layer. 

The description of the individual values is identical to the 

global values described above. 

 

 

 

 

 

 

 

 

 

 

 

 Advanced Edit ing  /  Path  Detai ls :  

Clicking on the "Path Details" button opens the following window: 

 

 

Segment selection 

In the upper left corner is a list of all segments that contain this file. Clicking on one of these 

segments turns this "light green". At the same time, the fields below this list become active. By un-

checking "Active" you can exclude the selected segment from the export. 
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 Double l ines  

This is useful if the file contains duplicate lines or elements that should not be milled / lasered. By 

checking the box marked "Show deleted" only the already deactivated elements are displayed. 

 

 Navigate  the  graphic  

While holding down the mouse button, you can move the image in the graphic, while holding down 

the right mouse button, you can zoom in. Click on the button "Reset Pan / Zoom" to restore the 

original state. 

 

 Optimize  the drawing f i le  

For files that consist of countless small line segments, it may be useful to sort the segments again 

and chain them together. This can be triggered by the "Optimize path" button. Unfortunately, this 

option is NOT reversible, so if an unexpected result arises, for example, with double lines, the 

import is to be repeated again. 

 

 The convers ion:  

After confirming the button Start conversion, the data will be converted into G-code and 

automatically loaded as a program. The converted data is documented for better understanding: 

 

(Kinetic-NC DXF Import Filter) 

(Filter Version: V1.0) 
(converted from: C:\DXF\samples_dxf\hasen.dxf) 
(circle mode JK relative) 
% 

N10 G64 (constant velocity mode) 
N20 G21 (metric) 
N30 G90 

N40 G0 Z50 (move to secure Z-hight) 

 

(Processing vector data from layer EBENE_1) 
(Tool Change) 
N50 Z55 

N60 M6 T1 
N70 M3 S1000 
N80 G0 Z50 
(Processing segment: 0, containing 603 elements) 

X-1.45876 Y4.08865 
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The generated code is partially optimized. This means, G commands and F commands are issued 

only when the command changes. Coordinates are only output if they differ from the current 

position. For better readability, however, the commands and parameters are separated by spaces. 

 

 

 Save  the  f i le  

The converted file is saved with the extension .nc in the same folder from which the .dxf file was 

opened. It is therefore important to ensure that the program KinetiC-NC also has write access to the 

disk from which the dxf file was opened (for example, not from a DC / DVD). 

 

 

 Special  features  when importing from DXF f i l es .  

Polylines are usually marked as closed or not. Unfortunately, this does not always work. Therefore, 

the import will see if the first point matches the last one. If that is the case, the line will always be 

marked as closed, even if it is open in the DXF file. If the file was saved as a closed line, but the 

endpoints do not match, the line will be closed. 

 

 

 Note  for experienced users  

Double elements:  

Unfortunately, many programs export DXF files very 

inaccurate. This includes, for example, Corel-Draw. 

This often happens because the lines in the drawing 

program have a certain thickness. Then the program 

will export each line page, creating double lines. But as 

this is often done in a very inconsistent and inaccurate 

way, very peculiar segments emerge. These are never 

100% identically congruent, but always differ slightly. 

The import filter does not want to decide here which 

segment was exported "better" or "worse". Also, it makes no sense to delete the really congruent 

elements and leave only the rest. 
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Remedy for bad templates 

During import, all contiguous segments are numbered and commented. 

If double lines are visible when opening a file, the best course of action is as follows: 

 

• Import the file with high feed values and small Z values for testing. 

• Test the file WITHOUT machine in demo mode. You can clearly see which are the "better" 

segments and which should be deleted. You can make a note of the wrong segment numbers 

in such a test run. 

• Import the file with the correct feeds and Z-values. 

• Open the file with the editor and remove all previously noted, duplicate segments. 

 

 No exist ing import  data  or message  "Error whi le         

pars ing the  DXF f i le ,  wrong version?  

It may happen that some programs in DXF export, e.g. Disassemble fonts into splines. The KinetiC-

NC import filter does not read any splines. In this case, try to save in an older file format, which 

still does not support splines, e.g. Autocad DXF R10 or older. 

Generally, it is a good practice to always use the oldest file format available for import errors. 
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 HPGL-Import  f i l ter  

 Short  descript ion  

The HPGL import filter is used to convert HPGL data into G-code for the KinetiC-NC control 

software. HPGL data files usually have the extension .hpgl or .plt and are provided by most drawing 

programs. These types of files are originally intended for controlling character plotters and cutting 

plotters. 

 

 Language supported:  

The HPGL import filter supports the following commands: 

IN, DF, IP, SC, VS, WU, PW, SP. PU, PD, PA, PR, AA, AR. 

All other HPGL commands are ignored. 

 

 The import  process  

To import an HPGL file, open it via "Menu-> File-> Import drawing". If the file is a valid, readable 

HPGL file, the following dialog opens: 
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The top list shows all the pens used. A pen in a HPGL file is originally a tool, and each of these 

pens can be assigned different properties. If you do not change anything, the same settings apply to 

all pens, tool 1 is used for all pens, and the workpiece origin is in the lower left corner. 

By clicking on "Start conversion", the HPGL file is converted to G-code and loaded as an NC 

program in KinetiC-NC. 

 

 

 Output  f i le  

The NC file is created in the same directory as the HPGL file to be imported. Therefore, make sure 

that the HPGL file is in a folder with write permissions. Do not import from a CD or DVD or a 

folder where you do not have write permission. 

 

 
(KinetiC-NC HPGL Import Filter) 

(Filter Version: V1.0) 

(converted from: C:\plotter\out\222.plt ) 

(circle mode JK relative) 

% 

N10 G64 (constant velocity mode) 

N20 G21 (metrical) 

N30 G90 

N40 G0 Z10 (move to secure Z-hight) 

 

(Tool Change) 

N50 M6 T1 

N60 M3 S10000 

N70 G0 Z10 

N80 G0 X0.3048 Y0.254 

 

The generated G code is commented on, and also contains information about the original file. 

 

 Customizing  the import  process  

You can adapt the global values to your needs and the material. 

If the import file contains several pens, you can configure these 

individually.  
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 Z-depth  

Z-depth is pen width PW 

In the HPGL file, widths can be assigned to the pens. If your drawing program supports it, you can 

use these values to comfortably adjust the Z depth. Just enter the desired depth as pen width in your 

drawing program and select this option. 

 

Z depth different for each pen 

If you select this option, you can specify an individual depth for each pen by right-clicking on the 

respective pen. 

 

 Tools  

If the "Extra tool for each pen" option is selected, you can right-click on the pen in the table above 

to select a different tool for each pen. 

 

 Feed  

Feed is pen speed VS 

In a HPGL file, individual speeds can be specified to the pens with the VS command. If your 

drawing program supports this, you can specify a speed for each pen when exporting. If you select 

this option, then the milling feed is automatically and comfortably taken over by each pin. 

 

Feed for pens is different 

With this option, an individual value can be specified for each pen. To do this, click on the desired 

pen in the upper list and set the feed individually. 

 

 Zero Offset  

This field allows you to specify where the zero point should be at the workpiece. This makes it 

possible, regardless of the information in the HPGL file, to move the zero point and thus 

comfortably adapt to his workpiece. 
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 General  set t ings  

Import from Corel-Draw 

CorelDraw is a very popular paint program, but unfortunately it generates a very inaccurate export 

of data. If you have exported data from CorelDraw, check this box to be able to import the file 

correctly. 

 

Save parameters 

If you make changes to the pens or global settings, they will be saved and automatically loaded 

again on the next import. If you do not want this, remove the check mark and you can change the 

data without saving it. By clicking on the button "Reset to default values" all settings are reset to the 

default values. 

 

CV-Mode 

In CV mode, curving and cornering do not slow down until the machine stops, but, similar to 

motorcycling, the "curve is cut". So you get a faster, jerk-free movement, but the path is not 100% 

accurate traversed. The maximum permissible error can be changed in the machine settings. 

 

 

Create line numbers 

The NC program thus contains line numbers. This can be useful if you want to interrupt the work 

and want to continue again to remember the position. 

 

Metric plot units 

Normally, a plotter unit is 0.0254mm, that is 1/1000 inch. But there are also programs, which set 

the export only 0.025mm as a unit. That's 1/1016 inches. If your part is not accurate and your 

drawing program uses this metric base, check the "Metric plotter units" box. 
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16  Customer service  

For technical information please contact our customer service: 

Address 

CNC-STEP GmbH & Co. KG 

Siemensstraße 13-15 

D-47608 Geldern 

 

 

Phone +49 (0)2831/91021-50 (Mo. - Fr. 07.00 am - 03.15 pm) 

Mobile 
+49 (0)2831/91021-20            

Only in urgent cases 

 

(Mo. - Thu. 03.15 pm – 06.00 pm) 

Fax +49 (0)2831/91021-99  

E-Mail support@cnc-step.de  

Web https://www.cnc-step.com/  

 

If you have any questions, please contact our customer service by e-mail or telephone. We are 

happy to help.  

 

 

Numerous suggestions and information can also be found on our website: 

 

https://www.cnc-step.com/ 

https://www.cnc-step.com/
https://www.cnc-step.com/

